BUDGET MANAGEMENT AND FINANCIAL REPORTING

Presented by:

AMANDA DUNLAP
COMMUNICATIONS & TRAINING COORDINATOR
OFFICE OF FINANCE

BRUCE AIRD
UNIVERSITY BUDGET OFFICER
BUDGET OFFICE

February 16, 2017
# TABLE OF CONTENTS

Overview and Objectives.................................................................3  
Definitions..........................................................................................4  
Fund/Ledger Information....................................................................8  
Accrual Accounting ...........................................................................11  
Budget Management (Minding the Store)...........................................12  
Establishing a New Budget.................................................................12  
Budget Unit Director’s Responsibilities............................................13  
Requesting Banner Finance Access..................................................14  
Master Signature List.........................................................................15  
Designating a Budget Unit Director...................................................15  
  BUD Delegates.................................................................................15  
Procedures and Guidelines for Budget Management..........................17  
  Budget adjustments/ Increases.........................................................17  
  Personal Services Increases/Decreases.............................................18  
  Overtime............................................................................................19  
  Equipment.........................................................................................19  
  Central Services................................................................................19  
  Fund Transfers..................................................................................20  
  Position Actions................................................................................22  
  Federal Workstudy Student Funds..................................................23  
  University Gift Management............................................................23  
  Exceptions.........................................................................................24  
  Fringe Benefits (4999 pool)..............................................................24  
Forecasting and Trend Analysis...........................................................25  
  Budget Office Variance Analysis......................................................25  
  Academic Affairs Variances..............................................................25  
Using Banner to Manage Your Budget...............................................26  
  Transaction Types............................................................................30  
    Accounts Payable Entries...............................................................30  
    Encumbrance Entries......................................................................31  
    Accounts Receivable Entries..........................................................32  
    Budget Entries................................................................................32  
    General Accounting Entries...........................................................32  
    Payroll Entries................................................................................33  
Managing/Monitoring Budgets..............................................................34  
Researching Invoices..........................................................................35  
Downloading Budget Information from Banner (into Excel)...............37  
Insight Budget Reporting.................................................................38  
Printing Month-End Financial Reports with ePrint...........................41  
Payroll Reports..................................................................................42  
Resolving Budget Discrepancies (IDTs and ASRs)..............................43  
Sample Test.........................................................................................50  
Screenshot of Budget Office website..................................................54  
Appendix – Downloading Budget Information from Banner into Excel ..56-62  
Appendix – Insight Budget Reporting................................................63-117  
Appendix – Printing Budget Reports with ePrint..............................118-148
Overview:

Under the Banner computer system, there are no automatically-generated monthly budget reports sent to departments. It is important to monitor transactions to ensure that information is posted accurately. Banner allows instant access to budget information on line. The information contained in this training session will assist you in monitoring your budget information in Banner and discuss the budget tools available to you. Departments are responsible for ensuring that budgets are monitored and that any negative variances are resolved timely. **Departments should reconcile budgets at least monthly.**

Objectives:

- What every Budget Unit Director should know about monitoring budgets (including Accrual Accounting, fund/ledger differences, Banner Finance access, master signature list, designating a budget unit director, and forecasting)
- Budget Unit Director (BUD) Responsibilities
- Budget Increases
- Budget Adjustments
- Guidelines
  - Personal Services
  - Overtime
  - Equipment
  - Work Study
  - Gift Management
  - Fringe Benefits
  - Fund Transfers
- What Banner forms to use to monitor budgets
- Transaction Types in Banner
- How to perform research
- About downloading select information into Excel
- About Insight Budget Reporting
- Printing Budget Reports with ePrint
How to report errors or request more detailed research

Terms and Definitions

# Auxiliary Services - Activities within the University, which furnish a service directly or indirectly to students and faculty, are considered auxiliary services. These activities charge fees directly related to, but not necessarily equal to, the cost of service. The public may also be served indirectly by some auxiliary services. These services are essential support elements of the institution’s program and are considered self-supporting.

# Budget Adjustment - When funds must be transferred from one budget to another, a budget adjustment form must be completed, signed by the budget unit director, and forwarded to the Budget Office for processing. This form must also be completed when moving funds from a "locked" line item (i.e., salaries, overtime) to another line item or pool account. Generally, funds are moved from pool account to pool account unless they fall into the "locked" (line item budgeted) category.

# Budget, Base – The annual budget commitment for ongoing operations of a department or area. Represents the “base” commitment of resources for operations. The base is not designed to fund special projects and/or temporary shifts in operating expenditures. The base budget may be modified during the course of an operating budget year and/or during the budget development process.

# Budget, Operating (OPAL) – The annual operating budgets of a department or area. The operating budget includes base funding as well as one-time funding for special projects and/or temporary shifts in operating expenditures. Budget units may shift funds within their operating budget to align resources with specific needs in a given year.

# Budget Prep - Each year, budget unit directors are required to put together an estimate of projected expenditures (including justification for increases or decreases) for the following fiscal year. The process of preparing the budget materials and submitting them for approval or modification is referred to as budget prep.

# Deposit - The term used to describe funds being put into a budget.

# E&G - Education and General (E&G) funds are made up of two allocations called general and nongeneral. The general funds are tax revenues collected by the State and appropriated to the University as our share of all tax revenues. The nongeneral funds are the tuition charges paid by students.
# Encumbrance - When a purchase order is issued, the funds for the purchase must be reserved. The process of reserving the funds is referred to as encumbrance. Once funds are encumbered, they are removed from the balance available. This prevents over-expenditures from occurring and allows departments to monitor available budget balances.

# Expenditures - Refers to the actual funds expended. When a vendor bill is paid, it becomes an expenditure.

# Equipment Trust Fund (ETF) - The Higher Education Equipment Trust Fund (HEETF) was established in 1986 by the General Assembly to provide funding to upgrade equipment needed for instruction and research. The State Council of Higher Education for Virginia (SCHEV) shares administrative responsibility for the program with the Virginia College Building Authority (VCBA) and the Department of Treasury.

# Fiscal Year - The University’s fiscal year runs from July 1 through June 30.

# Funds / Fund Balance – A Fund is a self-balancing set of accounts, segregated for specific purposes in accordance with laws and regulations or special restrictions and limitations. The Fund Balance is the residual balance of Revenues less Expenses of the accounts maintained within the fund.

# Indirect Costs – Auxiliary Enterprises units are required by the State to pay for the indirect costs of services received from E&G activities.

# Insufficient Funds - Prior to a purchase order being issued to a vendor, the funds must be encumbered. If funds in the budget are not adequate to cover the expected expenditure, this lack is referred to as insufficient funds. Funds must be available for all expenditures no matter the method of expenditure (PCard, travel reimbursement, wage/student expenses, etc.)

# Interdepartmental Transfer - When funds must be transferred between budgets at the University, an Interdepartmental Transfer Request (IDT) form must be completed and signed by both budget units affected. The IDT form is forwarded to the Office of Finance for processing. Transfers can be effected for the following reasons: to reimburse a department for expenditures, to pay for services rendered, or to correct an original charge from one budget to another.

# Journal Entry - This term refers to the actual computer entry to move revenues or expenditures from one department to another via an IDT (Interdepartmental Transfer).

# Line Item Budgeting - Certain expenditure items (for example, classified salaries, wages, overtime) are budgeted at the line item. Funds in these line items may be moved via budget adjustment only.
Liquidation - After a purchase order is complete, the vendor bill is paid. If the amount expended is less than the original amount encumbered, it is possible some funds will remain encumbered. The process of releasing those funds is referred to as liquidation. Liquidation requests are handled by Procurement Services.

NPS (Nonpersonal Services) – Contractual services, supplies and materials – made up of the sub-accounts in the 5000 and 6000 series.

ODS (Operational Data Store) - This is the product used for budget reporting using Insight. ODS is created using data from Banner. Reports are accessed via Insight.

One-Time (Revenues/Expenditures) – These are revenues or expenditures that are not recurring in nature and are specific to a given fiscal year or other short-time cycle. One-time funding may be approved in the budget process for a specific project or other program/purpose. This funding does not become part of the department’s base funding and is not included in the following year’s beginning budget.

Org Code - The terms "budget code" and "organization (org) code" are synonymous. They represent the five digit code used to identify the department for financial transactions (i.e., 1CL00 is the budget code for the Office of Finance).

Pool Budgeting - Refers to the items within the budget that are not "locked" into specific line item categories. Generally benefits, non-personal services, travel, and equipment use the pool budgeting method. (Benefits, 4999; NPS, 6999; Travel, 7999; Equipment, 9899).

Recovery refers to a special kind of budget used to recover funds expended by a service-oriented unit in the performance of approved activities. Recovery budgets may expend only funds for which they can charge-back other departments. For example, telephones are charged to departments as a recovery.

If funds being deposited are for recovery of services, they must be deposited to the appropriate recovery account. Recovery accounts can be either intra-agency recovery (recoveries from within the University) or inter-agency recovery (outside the University, but within the state).

Revenues are funds paid to the University for services or for donations. Revenues are recorded in the period in which they are earned, regardless of when the payment is actually received.
Established in 1956, The State Council of Higher Education for Virginia (SCHEV) is the Commonwealth's coordinating body for higher education. Their mission is "to promote the development of an educationally and economically sound, vigorous, progressive, and coordinated system of higher education" in Virginia.

Service Units are areas that provide specific types of services to the University community as a regular course of business. Examples of service units include Dining Services, telephones, and Facilities Management.

Sub-Object Code - The sub-object code is for use in identifying a category of expense or transfer payment in the budget process and for coding purchase requisitions, purchase orders, travel documents, etc.

Transfers - The act of moving money from one fund to another. Fund transfers are accounting transactions that move cash from one fund to another and are classified as mandatory (arising from binding legal agreements) and non-mandatory (agency discretion).

Vendor Number - All vendors doing business with Old Dominion University are identified by their Federal Employer Identification Number (FEIN) or, in the case of sole proprietorships, the University Identification Number (UIN). The University is required to have an IRS form W-9 (Request for Taxpayer Identification) or W-8BEN (international vendors/individuals) or an acceptable substitute on file for each vendor receiving payments from the University. No purchase orders or checks may be issued to vendors until Accounts Payable has this information on file. Departments are responsible for obtaining either the W-9 or the W-8BEN for new vendors. Please refer to Payment for Goods and Services for more information about vendor numbers and Independent Contractor payments.

Vouchers - Every expenditure made by the University has payment documentation (referred to as a voucher) for record-keeping purposes. A voucher may contain payment for more than one expenditure/invoice.
Fund/Ledger Information

Funds are utilized in Banner to manage and account for funding that is segregated for specific purposes in accordance with laws and regulations or special restrictions and limitations. Funds are further grouped by common designations and/or purposes and financial reporting requirements into what are referred to as Ledgers.

The table below highlights the common ledgers/fund groupings utilized by the University:

<table>
<thead>
<tr>
<th>Ledger</th>
<th>Local / State</th>
<th>Source</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>State</td>
<td>Tuition &amp; State Revenues</td>
<td>Educational &amp; General and other current unrestricted revenues and expenditures. Activities related to ODU’s educational objectives such as instruction, research, public service, academic support, student services, institutional support and maintenance of physical plant.</td>
</tr>
<tr>
<td>2</td>
<td>Local</td>
<td>Various</td>
<td>Local clearing accounts.</td>
</tr>
<tr>
<td>3</td>
<td>State</td>
<td>Student Fee funds and enterprise self-generated revenues</td>
<td>Auxiliary Enterprise (current unrestricted revenue and expenditures) are activities that exist to furnish goods or services to students, faculty and staff.</td>
</tr>
<tr>
<td>4</td>
<td>Local</td>
<td>Student Activity fees and self-generated revenues</td>
<td>Auxiliary Enterprise (current local unrestricted revenue and expenditures); Student activities, clubs and organizations.</td>
</tr>
<tr>
<td>5</td>
<td>Both</td>
<td>External funding from sponsored programs activities</td>
<td>Sponsored programs current restricted expenditures, such as grants, contracts or other externally funded activities.</td>
</tr>
<tr>
<td>6</td>
<td>Local</td>
<td>Gift Income</td>
<td>Restricted Gift funds for specific academic programs and initiatives.</td>
</tr>
<tr>
<td>7</td>
<td>State*</td>
<td>State Appropriation, Revenue Bonds, and Auxiliary Enterprise Funds</td>
<td>Capital Projects</td>
</tr>
<tr>
<td>8</td>
<td>Local</td>
<td>State Appropriation, Scholarship/Fellowships</td>
<td>Restricted Financial Aid and Scholarships, Fellowships, Eminent Scholarships</td>
</tr>
<tr>
<td>A</td>
<td>Local</td>
<td>External Agencies / Organizations</td>
<td>Funds held in custody for other agencies or organizations by the University. The University aids in the collection and disbursement of funds for the external entity.</td>
</tr>
</tbody>
</table>

Organization Codes, or Budget Units as they are often called, are utilized to record budget and financial transactions in Banner and represent the lowest level of the fund/ledger structure. Organization Codes are utilized in eVA, Banner and many other University systems to transact business. Organization Codes are all affiliated with a specific fund; however an individual fund may have more than one Organization Code affiliated with it. Using the Club and Rec Sports Fund from the table above as an example, you can see that there are multiple individual Organization Codes affiliated with this fund.
Notice that all of the Organization Codes in this example begin with a “4”. This simple approach to assigning organization codes makes it easy to identify which of the ledger groups a budget unit is associated with (4 = Local Auxiliary Services). A few additional examples are provided below:

<table>
<thead>
<tr>
<th>FUND_CODE</th>
<th>ORG_CODE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>025648</td>
<td>4AT87</td>
<td>SPORT CLUBS</td>
</tr>
<tr>
<td>025648</td>
<td>4AT88</td>
<td>INTRAMURAL/EXTRAMURAL PROGRAM</td>
</tr>
<tr>
<td>025648</td>
<td>4AT89</td>
<td>OUTDOOR ADVENTURE PROGRAM</td>
</tr>
<tr>
<td>025648</td>
<td>4AT90</td>
<td>FITNESS &amp; WELLNESS</td>
</tr>
<tr>
<td>025648</td>
<td>4AT91</td>
<td>REC &amp; WELLNESS FACILITY OPERATIONS</td>
</tr>
<tr>
<td>025648</td>
<td>4AT94</td>
<td>RECREATION &amp; OPERATIONS</td>
</tr>
<tr>
<td>025648</td>
<td>4AT95</td>
<td>REC SPORTS SUMMER CAMPS</td>
</tr>
</tbody>
</table>

Fund Restrictions

- **Restricted funds** may only be expended for the purposes indicated by the donor or grantor: includes gifts, grants, contracts, and financial aid, ledgers 5, 6, and 8. In the case of ledger 6 gift accounts, the Educational Foundation is responsible for maintaining complete records on restrictions.
  - If the grant or contract is “silent” on allowable expenditures, the CAPP Manual rules apply.

- **Unrestricted funds** are available for current operations at the discretion of the University within allowable guidelines: includes Educational and General Funds (E&G) and Auxiliary funds, ledgers 1, 2, 3, and 4.
  - *Unrestricted* does NOT mean uncontrolled, as CAPP Manual rules and University policy apply.
Organizational Hierarchy

The University leverages an organization code hierarchy in Banner to facilitate budget management and reporting in a manner that replicates the organizational structure of the University. There are five layers to the organization code hierarchy:

1. University
2. Vice Presidential Area
3. College of Division
4. Department or Office
5. Budget Code

The table below provides a few examples of this structure:

<table>
<thead>
<tr>
<th>University</th>
<th>Vice Presidential Area</th>
<th>College / Division</th>
<th>Department / Office</th>
<th>Budget Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000</td>
<td>00200 - Academic Affairs</td>
<td>21000 - Arts &amp; Letters</td>
<td>XAR00 - Art Department</td>
<td>1AR00 - Art</td>
</tr>
<tr>
<td>00000</td>
<td>00200 - Academic Affairs</td>
<td>21000 - Arts &amp; Letters</td>
<td>XAR00 - Art Department</td>
<td>6AR04 - Art Department Gifts</td>
</tr>
<tr>
<td>00000</td>
<td>00200 - Academic Affairs</td>
<td>21000 - Arts &amp; Letters</td>
<td>XEH00 - English Department</td>
<td>1EH00 - English</td>
</tr>
<tr>
<td>00000</td>
<td>00200 - Academic Affairs</td>
<td>21000 - Arts &amp; Letters</td>
<td>XEH00 - English Department</td>
<td>1EH05 - Writing Tutorial Services</td>
</tr>
<tr>
<td>00000</td>
<td>00300 - VP SEES</td>
<td>32000 - Enrollment Management</td>
<td>XAD00 - Enrollment Management</td>
<td>1AD00 - Undergraduate Admissions</td>
</tr>
<tr>
<td>00000</td>
<td>00300 - VP SEES</td>
<td>32000 - Enrollment Management</td>
<td>XRC00 - Registrar</td>
<td>1RC00 - Registrar</td>
</tr>
</tbody>
</table>

Several Banner inquiry forms, workflow/approvals, and all of the new Insight Reports utilize this organizational hierarchy to facilitate budget management and financial reporting.
Accrual Accounting

A. Accrual accounting means that revenues are recorded when they are earned, and/or the expenses are recorded when they are incurred. The date that goods and services are received determines the fiscal year in which the expenditure is recorded.

# Items received on or before June 30 - charged to current FY
# Items received on or after July 1 - charged to new FY

B. Although the University=s fiscal year closes on June 30, we must assure that all bills for goods and services received by June 30 are paid. We will also make corrections to expenditures that are incorrectly posted. This "13th" month will generally extend into late July (check the Year-End Closing Calendar for actual dates). During this time, the financial records will be adjusted to reflect all revenue receivables as of June 30 and all expenditures payable from the old fiscal year. Payables and expenditures will be posted to all budgets by mid-July to allow adequate time for budget review so that errors can be reported and corrected prior to the final year-end close. Revenue allocation adjustments between realized and deferred revenue will be allowed between July 30 and final close.

C. Budget information for both fiscal years should be monitored carefully during the accrual period (July) to ensure that expenditures are recorded in the correct fiscal year. Any errors detected should be reported immediately via an Accounting Service Request or Interdepartmental Transfer (IDT) whichever applies (see Error Correction Process section). Refer to the Year-End Closing Schedule for the deadlines to submit corrections via Accounting Services Request or IDT.

D. Budgets should be monitored by the budget unit director and reconciled at least monthly through the June 30 year-end to assure that budgets are not in deficit. Deficits must be resolved. Actual expenditures and your approved budget must be in synch so that your department does not receive a year-end budget variance report. The Budget Office sends periodic Budget Variance Reports to the President and Vice Presidents and to Budget Unit Directors.

E. Departments are responsible for making sure that all invoices are paid. Accounts Payable can only pay invoices if a department has completed the e-receiver in Banner authorizing payment and the vendor has submitted an invoice.
BUDGET MANAGEMENT (minding the store)

After the base budget is developed, approved, loaded into the budget system, and interfaced with the Banner Finance System to become the current operating budget, it cannot remain static. It will need to be changed and monitored as plans change or programs are added or deleted. In order to allow for these changes, there are procedures for adjusting the budget and guidelines for managing the budget. The rest of this guide addresses these elements.

Establishing a New Budget

Typically, a new organizational budgetary unit (Org) should be requested or will be determined to be necessary during the budget development process. However, as new grants are received during the course of the year, and/or as organizational changes and programs are implemented, new organizational budget units are also established outside of the budget development process.

The appropriate Banner access must be requested when a new budget is created – refer to the section Requesting Banner Finance Access.

The form and associated instructions utilized to request a new budgetary unit are available at: [http://www.odu.edu/facultystaff/university-business/budget/development/forms](http://www.odu.edu/facultystaff/university-business/budget/development/forms)

The request form entails:
- Indicating the appropriate classification (Ledger)
- The nature and frequency of funding to be received
- The nature and purpose of the expenditures to be incurred and any restrictions that may be made on the use of funds
- The length of time the org will be valid
- Identifying the Budget Unit Director for the Org
- Establishing whom will have signature authority for the Org

The request form must be approved by
- Grants Accounting
- Associated Dean/Director
- Associated Vice President (or Designee)
- University Budget Officer
- Associate Controller
- Finance Systems Manager
- Vice President for Research (for all Grants)
Budget Unit Director Responsibilities

University Policy #3001, Responsibility of Budget Unit Directors on Use of Funds (Expenditures), applies to all individuals designated as Budget Unit Directors having fiscal responsibility for University budgets. Budget Unit directors are responsible and accountable for all budgetary and fiscal matters pertaining to their respective department/college or unit. In instances where a fiscal transaction directly benefits the Budget Unit Director (e.g. travel expenses), the Budget Unit Director’s immediate supervisor must approve such transactions.

Budget Unit Directors (BUDs) are charged with being stewards of funds provided by the Commonwealth and the University, and ensuring they are expended to best serve the University and its mission. These responsibilities include:

- Adequate planning for use of funds and determining the availability of funds prior to initiating any expenditure action (no matter the funding source);
- Reviewing and ensuring all funds are expended in compliance with Commonwealth and/or University policies and that they are properly documented;
- Ensuring the funds are expended for the intended purpose and relate to the mission of the University; and
- Monitoring expenditures to ensure they do not exceed budget authority.

Budget Unit Directors may delegate signature authority. The delegation of signature authority does not relieve the BUD’s responsibility to ensure the appropriateness of the expenditure and compliance with Commonwealth and/or University Policies.

Failure of BUDs to abide by these policies and procedures may result in revocation of fiscal authority, personal liability, and/or disciplinary action. Please refer to the full policy for expenditure guidelines and allowable and disallowed expenditures.

http://www.odu.edu/content/dam/odu/policies/university/3000/univ-3001.pdf
Requesting Banner Finance Access

If you currently have a Banner account and need to add finance access (or to obtain Banner access for additional/new budgets), the budget unit director (or someone higher in the organizational structure than the individual requesting access if that person is the BUD) can send an e-mail to Linda Meyers (lmeyers@odu.edu), Finance Systems Manager in the Office of Finance.

If you do not currently have a Banner account, complete the Universal Account Request Form (available on the ITS web site).

http://www.odu.edu/content/dam/odu/offices/occs/docs/Universal%20Account%20Request%20Form.pdf

Fill out the first page – Be sure to indicate the type of user. Under “Accounts Needed,” check Banner. After completing the form, print the form, sign and date. Also at the bottom of the page, the Budget Unit Director (or someone higher in the organizational structure authorized to approve computer accounts) will need to complete the information in the authorization box and sign the form.

On the second page:

**In Section C**, include justification for obtaining the access (i.e., to be able to monitor budgets/research invoices).

**In Section D**, under Banner Classification Accesses Needed, request FIN_EVERYONE and list all budgets, including any ledger 6 budgets, to which you will need access.
Master Signature List (Authorized Signature List)

Individuals must be on the Master Signature List in order to sign against their budget codes for any purpose. A list of some areas that use the Master Signature List is shown below.

The Finance Systems Manager in Data Control is responsible for maintaining the Master Signature List for Old Dominion University. To be added to the Master Signature List, please complete the Request to be Added to the Master Signature List form. This fillable form is located on the Office of Finance website. The budget unit director for the budget should approve the request. Please note that continuation sheets must be submitted with the signed approval page.

If the person to be added to the Master Signature List is the budget unit director, someone higher in the organizational structure must approve the request.

**NOTE:** Signature authority will only be granted to Old Dominion University employees.

Current users of the Master Signature List include most service units that serve the Old Dominion University community:

- Bookstore
- Budget Office
- Procurement Services
- Technology Store
- Telecommunications
- Work Management (Facilities Management)
- Payroll
- Quick Copy
- Accounts Payable
- Mailroom

Designating a Budget Unit Director

Please note that adding an individual to the Master Signature List does not officially designate an individual as a Budget Unit Director (BUD). To officially designate an individual as a Budget Unit Director, the main BUD or BUD’s supervisor should send notification to the Finance Systems Manager, Data Control, Office of Finance. In Banner, the system shows the main BUD of record.

**BUD Delegates** - Budget Unit Directors may assign responsibility to Budget Delegates. These delegates will be able to approve all transactions/changes in the place of the main BUD, or responsibilities can be restricted to certain areas (i.e., Computer Account Requests). These delegates are maintained in MIDAS and are maintained by the Finance Systems Manager. Ultimate responsibility for departmental budgets rests with the main BUD.
Request to be Added to the Master Signature List – Old Dominion University

Attach continuation sheets to add additional names to the signature list for the same budget.

A signed page 1 must be attached to any continuation sheets.

Submit this form to add individuals to the Master Signature List. Individuals must be on the Master Signature List in order to sign against budget codes for any purpose.

Signature authority will only be granted to Old Dominion University employees.

The individual approving this request must be the Budget Unit Director (BUD) or an official BUD Delegate.

<table>
<thead>
<tr>
<th>Request Date</th>
<th>Org Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor Printed Name</td>
<td>Requestor Title</td>
</tr>
<tr>
<td><strong>Signature</strong></td>
<td></td>
</tr>
</tbody>
</table>

Please add the following individual(s) to the Master Signature List for the specified budget (org) code.

<table>
<thead>
<tr>
<th>Printed Name</th>
<th>UIN</th>
<th>Title</th>
<th>Campus Tel #:</th>
<th>Office Location</th>
<th>Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Submit this form to:

Linda Meyers
Finance Systems Manager
Office of Finance

Revised April 17, 2017
PROCEDURES AND GUIDELINES FOR BUDGET MANAGEMENT

Procedures and guidelines are necessary for managing budgets to ensure that Federal, State, and University policies are followed. In addition, the guidelines provide assurance that the appropriate levels of management stay abreast of material changes to the budget. The following information is updated annually near the beginning of the fiscal year and can be located on the Budget Office website. The actual web page containing the procedures and guidelines for budget management requires use of a Midas password to access this page. The contents from this web page are discussed in class.

Budget Adjustments / Increases

Budget re-allocations, both permanent and current, must be reviewed and recommended by the appropriate dean/director and approved by the appropriate senior executive officers. The University Budget Office approves and posts all budget adjustments. The table below represents minimum requirements for approval of budget adjustments.
Each Vice President has the ability to require additional levels of approval within their organizational structure. The following chart shows University requirements.

<table>
<thead>
<tr>
<th>Type of Transaction</th>
<th>Dollar Threshold</th>
<th>Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within a Single Org Unit</td>
<td>Up to $50,000</td>
<td>Dean or Director</td>
</tr>
<tr>
<td>Within a Single Org Unit</td>
<td>$50,000 to $1,000,000</td>
<td>All above PLUS the respective Vice President/Executive Officer</td>
</tr>
<tr>
<td>Within a Single Org Unit</td>
<td>$1,000,000 and up</td>
<td>All above plus the Vice President for Finance &amp; Administration or Chief Operating Officer</td>
</tr>
<tr>
<td>Cross Org Units</td>
<td>Up to $1,000,000</td>
<td>Respective Deans or Directors and Vice Presidents/ Executive Officers</td>
</tr>
<tr>
<td>Cross Org Units</td>
<td>$1,000,000 and Up</td>
<td>All above plus the Vice President for Finance &amp; Administration or Chief Operating Officer</td>
</tr>
</tbody>
</table>

**Exceptions:**

- **Academic Affairs:**
  - All budget adjustments and re-allocations must be routed through and approved by the Associate Vice President for Academic Affairs.
  - The Provost may centrally manage and/or allocate funding within Academic Affairs. These transactions are approved and posted by the University Budget Office and require approval of the Vice President for Finance & Administration or Chief Operating Officer should they exceed $1,000,000.
- The Budget Office retains delegated authority to record transactions related to Grants, Foundation Transfers, Revenues, Equipment Trust Fund, Fund Transfers, Financial Aid, Full-Time Salaries, Benefits, Capital Projects, Maintenance Reserves and other technical adjustments required by the Department of Planning and Budget.

**Additional Restrictions:**

- Departments may not move full-time salaries and fringes to NPS or any other areas without the Budget Office approval.
- Federal work study funds (Managed by Career Development Services) may not be moved to any other account codes.
- Only Budget Unit Directors of Auxiliary Services, CEPS, Grants, Agency Funds, and Gift Org Units may submit Revenue and Expenditure Increases/Decreases. These transactions must be approved by the respective Vice President/Executive Officer.
Revenues

Revenues are funds paid to the University for services provided to students, faculty, other agencies or the general public. They may also be received in the form of donations via any of the University Foundations. Revenues are recorded in the period in which they are earned, regardless of when the payment is actually received.

The majority of University revenues are monitored and managed centrally, with the exception of Auxiliary Services, CEPS, Gifts/Grants, and Agency Funds. Budget Unit Directors of these operating units are responsible for ensuring revenue budgets are developed and adhered to and must ensure the financial solvency of each respective operating unit.

Personal Services Increases/Decreases

The movement of funds among personal services and other expense categories of the budget must include a clear and concise reason for the change. Approval is in the hands of the Dean or Director and Vice President. If there is a pattern that materially changes the resource allocation, the Vice President for Administration and Finance or delegate will inform the President before acting on the request. The resource allocations for personal services must be monitored to ensure payroll costs are covered for University employees.

Overtime Pay

It is necessary to justify and budget pay for overtime work in the budget process. Send requirements after the budget process to the Budget Office for review. If the request relates to a classified employee exempt from the Fair Labor Standards Act, have Human Resources review the request first. Overtime increases are monitored and, where it appears there may be excessive use, the President's approval may be required. (Overtime is calculated automatically by Banner based on web time entry submissions. Not all employees are eligible for overtime. Overtime is discussed in the Payroll training class.)

Equipment

- The State established the Equipment Trust Fund (ETF) Authority to meet special equipment needs.
- The ETF program includes specific guidelines regarding the type of educational and research equipment that may be procured with ETF resources.
- In addition to maintaining compliance with these guidelines, the University must also maintain a minimum level of equipment purchases from the operating budget.
 ETF funding can be reduced or completely taken away if the University does not meet the minimum requirements or follow the ETF guidelines (distributed to departments).

The transfer of equipment funding in the operating budget to other categories of expense is monitored closely to ensure compliance and may require approval at the Vice Presidential level.

Central Services

Services such as telephones, mail charges, and photocopy charges are provided through central operations. As such, the costs are not invoiced, and the expense may appear in the budget sometime after the services are received. This kind of activity needs to be monitored on a monthly basis to avoid expenses in excess of the approved budget authority. Forecasting is very important to ensure accurate budget management. Telephone charges and mail charges generally have 12 months of charges.
Fund Transfers

Fund transfers are accounting transactions that move cash from one fund to another and are classified as mandatory and nonmandatory transfers (like moving money from one checking account to another).

**Mandatory** transfers are made on the basis of a legal obligation such as the repayment of principal and interest on construction bonds.

**Nonmandatory** transfers are made on the basis of needs within the University, and are done at agency discretion such as transfers from Housing and Residence Life to Facilities Management for custodial services, utilities, etc.

Fund transfers should be included in the budget process for approval. Requests to transfer cash after the budget process should be submitted to the Budget Office. If the transfer materially impacts the operating budget, the Vice President for Administration and Finance or designee will consult the President for a decision. If approved, the Budget Office will process the adjustment and notify the Assistant Vice President for Finance/University Controller that the transfer is approved.

When a fund transfer is posted in Banner, you will typically see two budget entries.

1. Increase or decrease expenditure sub-accounts
2. Increase or decrease sub-accounts within the 99XX group

The two entries are necessary to balance the respective budgets involved and have a zero effect on the bottom line of each budget. The department receiving the cash in the transfer will see an increase to one of their expenditure budget pools or line items to represent the increased expenditure authority and see a decrease in a transfer line item to represent the transfer of cash into their budget/fund.

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Title</th>
<th>Adjusted Budget</th>
<th>YTD Activity</th>
<th>Commit</th>
</tr>
</thead>
<tbody>
<tr>
<td>3603</td>
<td>PRIVATE GRANTS FUNDS</td>
<td>0.00</td>
<td>-1,225.00</td>
<td></td>
</tr>
<tr>
<td>5560</td>
<td>UNDERGRAD SCHOLARSHIPS</td>
<td>213,350.00</td>
<td>215,625.00</td>
<td></td>
</tr>
<tr>
<td>5656</td>
<td>TRANS FROM CW RESTRICTED</td>
<td>-213,350.00</td>
<td>-113,000.00</td>
<td></td>
</tr>
</tbody>
</table>
Position Actions

**New positions and position actions** - Requests for new positions and changes to an existing position should be proposed during the budget process. Only those that are approved in the budget process are usually acted on during the fiscal year. Thorough justification is required if you feel a position should be reviewed during the year. The first step in the process is to contact Human Resources to obtain the appropriate documents to be submitted. The cost of out-of-cycle requests will be funded from existing resources available in the budget. The President will provide funds only under extraordinary circumstances.

**Position transfers** - Positions may be transferred from one budget unit to another with approval of the vice president when it does not materially change the level of effort in the operating plan. The Budget Office reviews the request and sends it to Human Resources.

**Position recruitment** - Before recruiting for a vacant faculty, faculty administrator or faculty professional position outside of Academic Affairs, the request must be reviewed and approved by the Provost. Use the "Non-Academic Faculty and Administrative Position Allocation" form for this purpose. This form as well as others utilized in the recruitment process and associated guidelines are available at:


The completed form is sent through the Dean or Director and Vice President to the Budget Office. The Budget Office refers the request to the Provost.

**Attrition Funds** - Attrition funds are the monies remaining from a vacant position after all payroll and termination costs have been satisfied (i.e., classified leave payout). The types of positions that generate attrition are E&G funded faculty professional, faculty administrator and classified positions. Some examples of how attrition funds are generated include: (1) savings from positions being vacant for long periods of time, (2) savings when a member of the faculty or staff goes on leave without pay status.

Attrition funds are placed in the University's E&G contingency fund on a monthly basis via budget adjustment. The funds are used primarily to support unforeseen circumstances as well as to provide funding for specific projects that require funds on a one-time basis. Attrition funds may also be used to support emergency workload replacement or training needs at the request of the Budget Unit Director. Emergency workload replacement is to be associated with a specific vacancy in the budget unit.

Attrition requests should be sent to the Budget Office and must include justification for the use of attrition funds. The Budget Office will review the request and provide a recommendation based on an analysis of available attrition funds.
funding. The Budget Office will then notify the department with the outcome of the analysis.

**Surplus Salary Holding Account (4012)** – This University funding practice associated with Compensation Reform enables budget units to retain surplus salary funds accrued from hiring new classified staff at an annual salary that is lower than the current base funding for the given position.

- The Budget Office automatically calculates and reallocates the associated salary and benefit savings to the 4012 holding sub-account.
- Budget managers have the latitude to utilize these funds for compensation reform actions or to reallocate them for operating budget requirements.
- These reallocation actions may be made on a one-time basis or made permanent (base budget adjustment).

The 4012 surplus salary holding account will be considered part of departmental base budgets unless the Vice President and/or Dean prefers that these turnover surplus funds be held in a central reserve within your division.

**Federal Workstudy Student Funds (4028)**

The Federal government provides an annual grant that provides for hiring students at a subsidized rate. The grant provides 75 cents for every dollar of wage for students with a workstudy award. It is important that the University maximizes the use of these funds. Therefore, funds for workstudy student positions may not be transferred to any other expense category. Departments must monitor earnings to assure that students do not go into an over-award status. All workstudy funds are managed through Career Development Services.

**University Gift Management**

All gift funds are to be deposited to the Educational Foundation or Intercollegiate Foundation as appropriate. The foundations use the income from the investment of the gifts to support the operations. The transfers of gift funds to the University for expenditure (ledger 6) are planned as part of the budget process and include only those gift funds reported as being available to the University after July 1. Vice Presidents make recommendations for the use of the gifts in their budget materials. The approved funds are then transferred from the appropriate foundation account and entered into the departmental gift budgets shortly after the fiscal year begins. Ledger 6 budget balances from the prior fiscal year are loaded in late July, and the final adjusting balances are generally loaded in October, if applicable.

Departments should not automatically request transfer of all spendable funds from the Educational or Intercollegiate Foundations, but should only request those funds that will be needed to effectively conduct business.
The use of Foundation gifts by the University is a part of the budget process:

- Spendable Income Letter distributed by the Foundations in February detailing funds available for transfer on July 1.
- VPs make recommendations during the budget process and submit requests to the Budget Office in July.
- Funds transferred to the University in late September

**Exceptions** may be made to the above policy if required by the donor of the gift.

- An example would be a gift that is designated by the donor to be spent immediately.
- The exception request is to be approved by the Dean or Director and Vice President.
- After approvals, the request is forwarded to the Budget Office.
- The Budget Office will act on the request after conferring with the executive directors of the Educational Foundation and the Intercollegiate Foundation.
- **All foundation transfer requests should be forwarded to the Budget Office for processing.**

**Fringe Benefits (4999 pool)**

Fringe benefits for full-time employees in E&G budgets are managed centrally. Budget Unit Directors of Non E&G budgets must ensure sufficient funds are in 4999 to cover expenditures or make the appropriate budget adjustments.

- E&G – centrally managed – no action required to balance
- CEPS – must ensure sufficient funds in 4999 to cover benefits
- Auxiliaries, Gifts and Grants – must ensure sufficient funds in 4999 to cover benefits
- All Budget Unit Directors are responsible for monitoring and managing the benefits for their part-time positions (4021, 4031, 4027, and 4025 when students drop below the required credit hours)

Benefit rates are adjusted on an annual basis to reflect changes in premiums and contract costs. The University Budget Office publishes the benefits rates on its website.
Forecasting and Trends Analysis

It is important for all Budget Unit Directors to regularly monitor their respective budgets and periodically assess revenue and expenditure trends of their budgets. Understanding the typical spending patterns in conjunction with planned program activities will enable better budget planning for future budget cycles as well as forecasting of current year operations. It is the Budget Unit Director's responsibility to ensure their budgetary units stay within budget authority. Numerous Insight and ePrint reports may be utilized to assist Budget Unit Directors with both monitoring current budgets and analyzing revenue and expenditure trends.

Departments should establish a routine monthly process to monitor and evaluate outstanding purchase requests/orders, recurring charges (part-time employees, phone, copier, Small Purchasing Card), planned one-time expenditures, and overall current spending.

Budget Office Variance Analysis

Budget Unit Directors are responsible for ensuring that budgets are monitored and any deficits are corrected in a timely manner.

Budget Unit Directors are encouraged to use Insight, ePrint, and other tools to manage their budgets and ensure there are no negative variances. Departments will be contacted if large variances occur. The auditors recommend a formal once-a-month reconciliation. The BUD should sign off on the reconciliation.

Academic Affairs Variances

The Vice President/Provost distributes certain types of funding to deans, and the deans distribute funding to departments after the items are expensed (i.e., funding for graduate assistants and adjunct faculty), so there may be times when negative variances occur.

At the end of each fiscal year, the Budget Office conducts a formal analysis (Year-End Variance Analysis and Issues report) for each vice presidential area. The purpose of the analysis is to provide actual expenditures and trends for each budget unit manager, enhance the budget development for the next budget cycle, and allow for evaluation of the budget management for all areas.
Using Banner to Manage Your Budget
(Refer to the HOW DO I Do Banner Internal Financial Reporting revised July 2011)

Hard copy budget reports are not distributed to departments on a monthly or semi-monthly basis. A number of forms in Banner provide the information necessary to monitor departmental budgets online. You may also wish to use ePrint to print your month-end reports (discussed later – mandatory training must be attended).

Some general information about monitoring budgets

The Budget Availability Status Form (FGIBAVL) can be used to help you determine balances in the pool accounts. Periodically, it does not function properly and can show large, and sometimes inaccurate, deficits. The Budget Office is aware of the discrepancy and will not rely strictly on FGIBAVL to determine true budget deficits. In the past several years, this phenomenon has occurred only twice.

During times when budgets were out of balance, we discovered that a number of things cause the out-of-balance problems we were experiencing. Some of them are inherent in the system, since items that are in suspense or entered in error will display in FGIBAVL until posted or cleared.

Although we have resolved past problems with FGIBAVL showing inaccurate information, it is still possible that FGIBAVL and FGIBDST will not show identical information. REMEMBER, FGIBAVL is updated as data is entered and displays approved and unapproved, posted and unposted transactions. Please refer to "HOW DO I Do Banner Internal Financial Reporting."

You should continue to check your expenditures in Banner through the Organization Budget Status Form (FGIBDST) by linking to the Detail Transaction Activity Form (FGITRND). As long as your internal records match with the expenditures and encumbrances posted, your budget should be in good shape.

Even when FGIBAVL information is in balance, budget units are encouraged to reconcile budget information posted in the FGIBDST form against internal records. By performing regular reconciliation for each budget, departments can avoid end-of-year deficit problems.

Discrepancies from the Detail Transaction Activity Form (FGITRND) that cannot be identified once your budget is reconciled should be addressed through the Accounting Services Request (ASR) process. Do NOT contact an Accounts Payable processor with questions about postings to your budget.
Budget Availability Status Form (FGIBAVL)
This is a stand-alone form used to determine the available balance of a specific budget and provides available budget balances by line item and pools. From the *Options pull-down menu*, you can access Pending Documents (FGITINP) which shows pending transactions - no other research can be done from this form.

**By line item for**
- Personal services (4000 series of sub-accounts)
- Expense recoveries
- Transfers (99XX)

**At the pool level for**
- Benefits pool (4999 – 49XX sub-accounts except 4948 and 4949),
- Nonpersonal services pool (6999 - 5000-6000 series of sub-accounts),
- Travel pool (7999 - 7000 series of sub-accounts),
- Equipment pool (9899 - 9000 series of sub-accounts)

FGIBAVL shows the current operating expenditure budget, less year-to-date activity and commitments to arrive at the balance. Refer to HOW DO I Check My Available Balance revised July 2011, for more details on how to use this form.

This form is updated as data is entered and displays both *approved* and *unapproved* transactions.

Actual detailed expenditure data is obtained through the Organization Budget Status Form (FGIBDST).

**Organization Budget Status Form (FGIBDST) – where you find details**
This form shows budget, actual activity and encumbrances and shows available balances *by line item only*. It does not provide a net budget balance. It also allows you to drill down to detailed information on a specific transaction. You can perform detailed research from this form. This form is updated *after posting and approval processes are completed*. Detailed instructions on how to access this Banner form are available in *How Do I Check My Budget* discussed during Banner training.

**Researching from the Organization Budget Status Form (FGIBDST)**
The following forms can be accessed from the Organization Budget Status Form (FGIBDST) by selecting the appropriate option.

**Organizational Budget Summary Form (FGIBSUM)**
This form shows a summary of budget information by revenue, total personal and nonpersonal expenditures and transfers (if applicable) for a specific organization. This form can be accessed from the Organizational Budget Status Form (FGIBDST) by selecting Budget Summary Information from the Options pull-down menu.
Detail Transaction Activity Form (FGITRND)
This form provides a detailed transaction listing of the sub-account highlighted on the Organization Budget Status Form (FGIBDST) and can be accessed by selecting Transaction Detail Information from the Options pull-down menu. You can use the scroll bar beneath the details to move the window pane to the right to reveal additional information about entries. When requesting corrections to your budget, you should print the screen of information related to the transaction. This form shows the details of expenditures in the selected sub-object code. The date an invoice is posted to this form (INEI or INNI) is the date the payment process starts and is not necessarily the date that a check was mailed. To see a payment due date, you must review details of the invoice payment (FAIINVE).

Invoice/Credit Memo Query Form (FAIINVE)
This form shows the date that an invoice is scheduled to be paid and to what address a check will be mailed. Can be accessed from the Detail Transaction Activity Form (FGITRND) by selecting Query Document from the Options pull-down menu when looking up information on invoices (INEI, INNI) when you see YTD in the Field column.

Detail Encumbrance Activity Form (FGIENC)
When ENC shows in the column labeled Field, you can view the encumbrance activity. (Once an encumbrance is liquidated, you can no longer view it from the Organization Encumbrance List Form, FGIOENC). This form shows detailed information about a specific encumbrance. This form can be accessed by selecting Detail Encumbrance Information from the Options pull-down menu from FGITRND.

Document Retrieval Inquiry Form (FGIDOCR)
This form provides detailed information about all transaction types. Can be accessed from the Detail Transaction Activity Form (FGITRND) by selecting Query Document from the Options pull-down menu when looking up information on budget adjustments (BD02) and journal entries (JE35, etc.) when you see OBD, ABD, or YTD in the Field column.

Document Postings Form (FGQDOCP)
Shows how transactions post into each ledger. This form can be accessed only from the Document Retrieval Inquiry Form (FGIDOCR) by selecting Access Document Postings from the Options pull-down menu.

General Text Entry Form (FOATEXT)
Shows text descriptions for journal entry type transactions, if entered. This form can be accessed from the Document Postings Form (FGQDOCP) by selecting Document Text from the Options pull-down menu.
Organization Encumbrance List Form (FGIOENC)
Shows detailed information about open encumbrances. Can be accessed from the Organization Budget Status Form (FGIBDST) by selecting **Organization Encumbrances** from the Options pull-down menu.

**Detail Encumbrance Activity Form (FGIENCD)**
Shows detailed information about a specific encumbrance. Accessed from the Organization Encumbrance List form (FGIOENC) by selecting **Query Detail Encumbrance Info** from the Options pull-down menu.

**Document History Form (FOIDOCH)**
This form shows the life of a document – purchase order, invoice, check, and receiving. (Refer to *How to Research an Invoice Using the Banner Invoice Number*).

**Vendor Detail History Form (FAIVNDH)**
You can see payment history for a specific vendor.

**Entity Name/ID Search (FTIIDEN)**
This form allows you to see if a vendor is in the University’s vendor table. A vendor can be an eVA vendor but not be in the University’s vendor table. If a vendor is not in ODU’s vendor table, the ordering department is responsible for obtaining a W-9 or W8BEN (international vendors). Remember to use ALL CAPS.

**Budget Query Form (FBIBUDG)**
There are times when departments need to review the base budget versus the current operating budget. FBIBUDG is **query-only** and enables departments to review continuation costs for a full fiscal year. Only the University Budget Office has authorization to modify base budgets in accordance with the annual University budget approval process and as operating year adjustments impact the base. Remember, base budgets do **not** reflect one-time funds.

Perhaps the easiest way to illustrate the difference between a base and an operating budget is when a position is vacant for a period of time during the fiscal year. Refilling a vacant position requires that funds be available to cover only those costs to be expended in the current operating year whereas the base budget must factor in the ensuing full fiscal year’s continuation costs.

Departments who have access to FBIBUDG can review information on only those budgets requested on the Computer Account Request Form. Questions about base budget information can be directed to the Budget Office at 683-3127.
Transaction Types

Reviewing budget information is important. To aid departments in understanding Banner Finance, the following transaction codes are provided.

<table>
<thead>
<tr>
<th>Banner Code</th>
<th>Action</th>
<th>Sign (debit or credit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCI</td>
<td>Cancel Addl Chrgs on Inv w/G/L Acct</td>
<td></td>
</tr>
<tr>
<td>ACDC</td>
<td>Cancel Addl Charges on Credit Memo</td>
<td></td>
</tr>
<tr>
<td>ACDI</td>
<td>Cancel Addl Charges on Invoice</td>
<td></td>
</tr>
<tr>
<td>ACEC</td>
<td>Cancel Addl Chrg on C/M w/Encumb</td>
<td></td>
</tr>
<tr>
<td>ACEI</td>
<td>Cancel Addl Chrg on Inv w/Encumb</td>
<td></td>
</tr>
<tr>
<td>ADDC</td>
<td>Additional Charges on Credit Memo</td>
<td></td>
</tr>
<tr>
<td>ADDI</td>
<td>Additional Charges on an Invoice</td>
<td></td>
</tr>
<tr>
<td>ADEC</td>
<td>Addl Chrg on Credit Memo w/ Encumb</td>
<td></td>
</tr>
<tr>
<td>ADEI</td>
<td>Addl Charges on Invoice w/Encumb</td>
<td></td>
</tr>
<tr>
<td>ADII</td>
<td>Addl Charges on Invoice w/G/L Acct</td>
<td></td>
</tr>
<tr>
<td>CNEI</td>
<td>Cancel check - Invoice w/Encumbrance</td>
<td></td>
</tr>
<tr>
<td>CNNC</td>
<td>Cancel Check - C/M w/o Encumbrance</td>
<td></td>
</tr>
<tr>
<td>DNEC</td>
<td>Check - Invoice w/Encumbrance</td>
<td></td>
</tr>
<tr>
<td>DNII</td>
<td>Check - Inventory Invoice</td>
<td></td>
</tr>
<tr>
<td>DNNC</td>
<td>Check - C/M w/o Encumbrance</td>
<td></td>
</tr>
<tr>
<td>DNNI</td>
<td>Check - Invoice w/o Encumbrance</td>
<td></td>
</tr>
<tr>
<td>CNNI</td>
<td>Cancel Check Inventory Invoice</td>
<td></td>
</tr>
<tr>
<td>Banner Code</td>
<td>Action</td>
<td>Sign (debit or credit)</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>ICEC</td>
<td>Cancel Credit Memo w/Encumbrance</td>
<td></td>
</tr>
<tr>
<td>ICEI</td>
<td>Cancel Invoice with Encumbrance</td>
<td></td>
</tr>
<tr>
<td>ICNI</td>
<td>Cancel Invoice without Encumbrance</td>
<td></td>
</tr>
<tr>
<td>INEC</td>
<td>Credit Memo with Encumbrance</td>
<td></td>
</tr>
<tr>
<td>INEI</td>
<td>Invoice with Encumbrance</td>
<td></td>
</tr>
<tr>
<td>INEP</td>
<td>Invoice with Encumbrance Charged PY</td>
<td></td>
</tr>
<tr>
<td>INER</td>
<td>Credit Memo with Encumbrance PY</td>
<td></td>
</tr>
<tr>
<td>INNC</td>
<td>Credit Memo without Encumbrance</td>
<td></td>
</tr>
<tr>
<td>INNI</td>
<td>Invoice Without Encumbrance</td>
<td></td>
</tr>
<tr>
<td>COAD</td>
<td>Additional Charge on Change Order</td>
<td></td>
</tr>
<tr>
<td>CORD</td>
<td>Establish Change Order</td>
<td></td>
</tr>
<tr>
<td>E010</td>
<td>Post Original Encumbrance (LPOs)</td>
<td></td>
</tr>
<tr>
<td>E020</td>
<td>Encumbrance Adjustment</td>
<td></td>
</tr>
<tr>
<td>E032</td>
<td>Encumbrance Liquidation</td>
<td>+ or -</td>
</tr>
<tr>
<td>E037</td>
<td>Encumbrance Liq. allow changes</td>
<td></td>
</tr>
<tr>
<td>E090</td>
<td>Encumbrance Year End Roll</td>
<td></td>
</tr>
<tr>
<td>E100</td>
<td>Original Encumbrance</td>
<td></td>
</tr>
<tr>
<td>PCAD</td>
<td>Cancel Add=1 Chrg on Purchase Order</td>
<td></td>
</tr>
<tr>
<td>PCAP</td>
<td>Canc Addl Chg on Purchase Order PY</td>
<td></td>
</tr>
<tr>
<td>PCDP</td>
<td>Canc Disc on Purchase Order Prior Y</td>
<td></td>
</tr>
<tr>
<td>PCDS</td>
<td>Cancel Discount on Purchase Order</td>
<td></td>
</tr>
<tr>
<td>PCLQ</td>
<td>Cancel PO - Reinstat Request</td>
<td></td>
</tr>
<tr>
<td>PCRD</td>
<td>Cancel Purchase Order</td>
<td></td>
</tr>
<tr>
<td>PCRP</td>
<td>Cancel Purchase Order in Prior Year</td>
<td></td>
</tr>
<tr>
<td>Banner Code</td>
<td>Action</td>
<td>Sign (debit or credit)</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>POAD</td>
<td>Additional Charge on Purchase Order</td>
<td></td>
</tr>
<tr>
<td>POAP</td>
<td>Additional Chg on PO Prior YR</td>
<td></td>
</tr>
<tr>
<td>POCL</td>
<td>Purchase Order Close</td>
<td></td>
</tr>
<tr>
<td>PODP</td>
<td>Disc on Purchase Order Prior Year</td>
<td></td>
</tr>
<tr>
<td>PODS</td>
<td>Discount on Purchase Order</td>
<td></td>
</tr>
<tr>
<td>POLQ</td>
<td>Purchase Order - Request Liquidation</td>
<td></td>
</tr>
<tr>
<td>PORD</td>
<td>Establish Purchase Order</td>
<td></td>
</tr>
<tr>
<td>RCQP</td>
<td>Cancel Requisition</td>
<td></td>
</tr>
<tr>
<td>REQP</td>
<td>Requisition - Reservation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accounts Receivable Entries</td>
<td></td>
</tr>
<tr>
<td>IS01</td>
<td>ISIS AR Legacy Interface *</td>
<td></td>
</tr>
<tr>
<td>IS02</td>
<td>ISIS AR Legacy Interface *</td>
<td></td>
</tr>
<tr>
<td>CHS1</td>
<td>Banner Student Charges/Non-Cash Pay</td>
<td></td>
</tr>
<tr>
<td>CSS1</td>
<td>Banner Student Cash Payments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Budget Entries</td>
<td></td>
</tr>
<tr>
<td>BD01</td>
<td>Original Budget Entries</td>
<td>+ or -</td>
</tr>
<tr>
<td>BD02</td>
<td>Permanent Budget Adjustments</td>
<td>+ or -</td>
</tr>
<tr>
<td></td>
<td>General Accounting Entries</td>
<td></td>
</tr>
<tr>
<td>DCSR</td>
<td>Direct Cash Receipts</td>
<td>+ or -</td>
</tr>
<tr>
<td>J001</td>
<td>Year End Closing Journal</td>
<td>D or C</td>
</tr>
<tr>
<td>J020</td>
<td>Budget Carry Forward Journal</td>
<td>D or C</td>
</tr>
<tr>
<td>JE05</td>
<td>Beginning balances</td>
<td>D or C</td>
</tr>
<tr>
<td>JE35</td>
<td>Transfer within funds</td>
<td>D or C</td>
</tr>
<tr>
<td>JE36</td>
<td>Transfer within funds Banner only</td>
<td>D or C</td>
</tr>
<tr>
<td>JE60</td>
<td>Transfer between funds</td>
<td>D or C</td>
</tr>
<tr>
<td>JE61</td>
<td>Transfer between funds Banner only</td>
<td>D or C</td>
</tr>
</tbody>
</table>
### Banner Code | Action | Sign (debit or credit)
--- | --- | ---
Payroll Entries

<table>
<thead>
<tr>
<th>Banner Code</th>
<th>Action</th>
<th>Sign (debit or credit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR01</td>
<td>HRIS PR Legacy Interface *</td>
<td></td>
</tr>
<tr>
<td>HEEL</td>
<td>Payroll - Employee Liability</td>
<td></td>
</tr>
<tr>
<td>HENA</td>
<td>Payroll ▶ Encumbrance Adjustment</td>
<td></td>
</tr>
<tr>
<td>HENC</td>
<td>Payroll ▶ Salary Encumbrance</td>
<td></td>
</tr>
<tr>
<td>HERL</td>
<td>Payroll - Employer Liability</td>
<td></td>
</tr>
<tr>
<td>HGNL</td>
<td>Payroll ▶ Gross Expenditure</td>
<td></td>
</tr>
<tr>
<td>HGRB</td>
<td>Payroll ▶ Gross Benefit Expense</td>
<td></td>
</tr>
</tbody>
</table>
MANAGING/MONITORING BUDGETS

Departments are responsible for monitoring budget activity and resolving any budget variances timely (recommended monthly). Banner is the University’s official financial record and any discrepancies or errors must be reported and corrected via the appropriate process. Please refer to the Error Correction Process section.

Researching Invoices

If you need to see if an invoice has been paid, you should research the invoice before calling the Accounts Payable processors. Please keep in mind that the date an invoice is posted in Banner is the date that the payment process begins and is not always the date the payment was sent to the vendor. If you have not completed the e-receiver in Banner - the payment process cannot begin. The completed e-receiver serves as payment authorization. (Refer to Procurement and Payment for Goods and Services for more information.)

If you cannot find the information you need, please contact the appropriate processor. You will need to provide:

1. The purchase order number (or UIN if payment was made to an individual)
2. The vendor name
3. The invoice number
4. And the date the e-receiver was completed in Banner.

You can check FOIDOCH to see if the invoice has been received and/or the e-receiver has been completed.

The information on the following pages is available to all Banner Finance account holders and is available on the Office of Finance web site at the following address:

http://www.odu.edu/facultystaff/training-development/banner-training/finance-budget
How to Research an Invoice Using the Banner Invoice Number

<table>
<thead>
<tr>
<th>ACTIONS/STEPS</th>
<th>NOTES/HINTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Access the <em>Document History Form</em></td>
<td>Type <em>FOIDOCH</em> in the “Go to” box and press &lt;ENTER&gt;.</td>
</tr>
</tbody>
</table>
| X The Document History Form (FOIDOCH) contains two (2) blocks which must be completed:  
  ▪ **Doc Type.** Type INV (for invoice) or PO (for purchase order)  
  ▪ **Doc Code:** Type the invoice number or PO number | The invoice number used in this form is the system-generated document number which begins with A@ that can be found in FGITRD. |
| X Perform the **Next Block** function to load all the information about the invoice. | **Ctrl + Page Down** |
| X A number of different windows of information will be displayed. In the **Invoice** window, the invoice number will be displayed. In the **Check** window, the check number will be displayed if a check has been issued. A one-character **Status Indicator** displays the status.  
*Under “Invoice,” if you see an R displayed, you need to complete an e-receiver in Banner. If no invoice information displays, invoice has not been received and/or scanned/indexed.*  
*Under “Receiver,” you can see the receiving documents associated with the invoice. Must display a “C” for completed.*  
*Under “Check,” you can see the check number.* | Status Indicators (legend)  
(A) Approved  
(C) Completed  
(F) Final Reconciliation  
(P) Paid  
(R) Receipt Required (needs e-receiver)  
(S) Suspended  
(O) Open  
(X) Cancelled  
(V) Void  
(H) Hold  
(T) Tagged Permanently |
| X To find the check date, make sure the **Check** window is highlighted. | Use your mouse pointer to **click** into the **Check** window. On most screens it will be highlighted in blue. |
| X Select **Check Information** from the **Options** pull-down menu. |  |
| X This will take you to a blank **Check Payment History Form (FAICHKH)** with the **Check Number** filled in. Fill in the **Bank #** (50 or 01). Use the **Next Block** function to display all the information about the check. | **Ctrl + Page Down** |
| X The top portion of this window of the form displays the **Check Number**, **Vendor**, **Check Date**, and **Cancel Date** (if applicable). Checks are scheduled to be mailed within seven (7) work days of the check date. If a check was cancelled for some reason, the date of cancellation will be displayed. | Since all checks are done as a “batch.” It is possible that the check will include payments for multiple invoices. |
| X Once you find all the information you need on a specific invoice, click on the **Exit** icon in the toolbar and you will be returned to the Document History Form (FOIDOCH) displaying the various windows of information about the invoice (Invoice, Check, etc.). |  |
| X If you wish to perform research on another invoice, **click** on the **Rollback** icon in the toolbar. This will take you back to the **FOIDOCH** form key information area. | The **Rollback** icon is the second from the left on the toolbar. |
### How to Research an Invoice Using Vendor History

<table>
<thead>
<tr>
<th>ACTIONS/STEPS</th>
<th>NOTES/HINTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Access the <strong>Vendor Detail History Form</strong></td>
<td>Type \textit{FAIVNDH} in the “Go to” field and press \textit{&lt;ENTER&gt;}.</td>
</tr>
<tr>
<td>X The key information area of the <strong>Detail History Form</strong> (FAIVNDH) contains three (3) fields which must be completed:</td>
<td>Other selections are Credit Memo, Open, Paid.</td>
</tr>
<tr>
<td>- <strong>Vendor</strong>: Enter the Vendor Number</td>
<td></td>
</tr>
<tr>
<td>- <strong>Selection</strong>: Defaults to All</td>
<td></td>
</tr>
<tr>
<td>- <strong>Fiscal Year</strong>: Defaults to current fiscal year</td>
<td></td>
</tr>
<tr>
<td>X Perform the <strong>Next Block</strong> function to load all the information about the vendor=s payment history. The following information is displayed:</td>
<td><strong>Ctrl + Page Down</strong></td>
</tr>
<tr>
<td>X <strong>Vendor Invoice</strong> is a listing of all invoices for this vendor</td>
<td>When you view a listing of vendor invoices, keep in mind that all invoices processed by the University for this vendor are shown here.</td>
</tr>
<tr>
<td>X <strong>Invoice</strong> refers to the system-generated reference number</td>
<td>You can also view the invoice info by selecting <strong>View Invoice Information</strong> from the <strong>Options</strong> pull-down menu.</td>
</tr>
<tr>
<td>X <strong>Approval</strong> shows if an item was approved (Y or N)</td>
<td>The check date is generally about a week before mailing – allows for auditing.</td>
</tr>
<tr>
<td>X <strong>VIC Ind</strong> (not used at this time)</td>
<td></td>
</tr>
<tr>
<td>X <strong>Credit Memo</strong> shows if an item is a credit memo (Y or N)</td>
<td></td>
</tr>
<tr>
<td>X <strong>Open/Paid</strong> indicates O(pen) or P(aid)</td>
<td></td>
</tr>
<tr>
<td>X <strong>Cancel</strong> shows if an item has been cancelled (Y or N)</td>
<td></td>
</tr>
<tr>
<td>X <strong>Vendor Invoice Amt</strong> is the amount of that specific transaction</td>
<td></td>
</tr>
<tr>
<td>X <strong>Due Date</strong> displays the date an invoice is expected to be paid</td>
<td></td>
</tr>
<tr>
<td>X <strong>Check Date</strong> when the check is cut, displays the check date</td>
<td></td>
</tr>
<tr>
<td>X <strong>Check Number</strong> (click on the <strong>Details</strong> icon (\square) to see check details)</td>
<td></td>
</tr>
<tr>
<td>X Click on <strong>Rollback</strong> to return to the key information area of the form to review the payment history for another vendor.</td>
<td></td>
</tr>
<tr>
<td>X Remember to log out of Banner to assure the security of information.</td>
<td>Click on the <strong>Exit</strong> icon in the toolbar.</td>
</tr>
</tbody>
</table>
## Downloading Budget Information from Banner (into Excel)

Departments can download select budget data into Excel spreadsheets. This provides departments with another tool to more effectively manage budgets. This download process should not be confused with the Insight budget reports available via Insight (see next section). You can only download data for budgets to which you have Banner access. You may not have access to all forms if they are not included in your current Banner access. Once you have set up your output options that determine where you want your Excel files stored, you can download information.

The Banner forms in the chart below contain select information that can be downloaded into a basic Excel spreadsheet. Once you download the information, you can modify the spreadsheet formatting to suit your needs.

The full documentation about downloading to Excel can be found on the Office of Finance web site (part of the Banner Finance training) and in the appendix of this document:

<table>
<thead>
<tr>
<th>Form Name</th>
<th>Descriptive Name</th>
<th>Info Contained</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FGIBAVL</td>
<td>Budget Availability Status</td>
<td>Summary data at org level</td>
<td>Shows line-item sub-accounts and pool accounts</td>
</tr>
<tr>
<td>FGIBDSR</td>
<td>Executive Summary</td>
<td>Summary budget data at any org level, including fund</td>
<td></td>
</tr>
<tr>
<td>FGIBDST</td>
<td>Organization Budget Status</td>
<td>Summary budget data at org level</td>
<td>Shows all sub-accounts</td>
</tr>
<tr>
<td>FGIBSUM</td>
<td>Organization Budget Summary</td>
<td>Summary by account type</td>
<td></td>
</tr>
<tr>
<td>FGIDOOCR</td>
<td>Document Retrieval Inquiry</td>
<td>Transaction detail for any completed document</td>
<td></td>
</tr>
<tr>
<td>FGIEHC</td>
<td>Detail Encumbrance Activity</td>
<td>Contains encumbrance detail – shows payee, vendor number, coding and amounts – downloads header, encumbrance number and accounting distribution only</td>
<td>Vendor number DOES NOT download to Excel. Individual transactions do not download.</td>
</tr>
<tr>
<td>FGIIJSUM</td>
<td>Journal Voucher Summary</td>
<td>Shows incomplete journal entries</td>
<td>For use with incomplete journal vouchers only.</td>
</tr>
<tr>
<td>FGIOENC</td>
<td>Organizational Encumbrance List</td>
<td>Shows open encumbrances by number, payee and amount – no vendor numbers</td>
<td></td>
</tr>
</tbody>
</table>

For the following forms, from the Help pull-down menu - select “Extract Data No Key."

<table>
<thead>
<tr>
<th>Form Name</th>
<th>Descriptive Name</th>
<th>Info Contained</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FGIEHCB</td>
<td>Encumbrance List</td>
<td>Shows encumbrance list by number, amount and date – no vendor numbers</td>
<td>WARNING – do not try to download the entire list – it is too large.</td>
</tr>
</tbody>
</table>

---

*Part of the Certificate in University Financial Management, revised February 16, 2017*
Insight Budget Reporting

Insight Budget Reporting is another tool that may be leveraged to monitor and manage budgets. The data used for these reports is read from the Operational Data Store (ODS), which is created from the Banner database and is currently refreshed daily between Midnight and 6AM every day. The refresh picks up all changes in Banner since the last refresh and performs an ETL (Extract, Transform, and Load) process on the data to make it more useful and user-friendly for reporting purposes. The reports are not updated as activity is posted during the day.

Please feel free to contact Bruce Aird, Associate Budget Officer with any questions about utilizing the Insight Budget Reports and/or the data contained in the Budget Reports. (683-3127 or baird@odu.edu).

- Insight is currently being updated.
- **You no longer need to activate Insight via MIDAS.**
- **You must have the appropriate Banner access to all the budgets you wish to view.**
  - If you have access to a specific budget, you will have access to Insight reports for that budget.
  - Insight reports can be easily saved as a PDF or Excel document or e-mailed directly from Insight for easy distribution and use.
  - Reports may be scheduled to run on specific dates/times.
  - Detailed training on Insight Reporting is provided periodically by the Budget Office.
  - Please refer to the Appendix in this handout for the most recent full documentation for Insight Budget Reporting.

http://insight.odu.edu/

There are multiple reports and report options available via Insight:

- Base Budget
- Budget Trend
- Current Operating Budget (OPAL)
- Fund/Auxiliary Budgets
- Transaction/Sub-account Detail

Here are just a few of the reports available:

- COB by Budget by Revenue/Expense/Transfers (FGIBDST)
- COB by Budget by Revenue/Expense/Transfers by Subaccount (FGIBDST)
- Current Operating Budget Revenue Report (FGIBDST)
- Auxiliary Fund Rollup Report
- Negative Budget Balances Report (FGIBAVL) – by Budget Code/Hierarchy
- Budget Transactions Matrix Report (FGITRND) – total reconciliation trail
IE 11

If you are using IE 11 you might get an error about the reports being "Undefined". Please follow the steps in the help document to resolve the issue.

BI Initiative

Capturing data—from customers, partners, employees and operations—has always been a part of running a university, but using this information proactively has become essential. Business Intelligence provides a platform in which the university community can make data driven decisions in a timely and accurate manner. Information is provided at the operational, decision support and executive level so constituents are able to make sound data driven decisions that impact the university.

Business Intelligence is a strategic endeavor that will allow the university to make good data driven decisions at all levels thus allowing the university to find opportunities, accept new challenges, grow and flourish.

Resources

Other than the links available on the side, there is plenty to offer to the BI consumers at ODU. We are in the process of documenting more and more help documents for our users to have a rich experience when using Insight. We are available to respond to any queries and suggestions at insight@odu.edu

You do not need to activate Insight via UTDAS.

Your access to reports matches your Banner Finance access.

You must periodically log into Banner in order to keep your Banner
Budget Report Menu

Budget Tracking

Budget Reports

- Base Budgets
- Budget Trends
- Current Budget Balances
- Current Budget Reports
- Fund Code/Auxiliary
- Transactions/Subaccounts

Budget Transaction Matrix Report

<table>
<thead>
<tr>
<th>TRANSACTION_AMOUNT</th>
<th>ACB</th>
<th>YTD</th>
<th>ENC</th>
</tr>
</thead>
<tbody>
<tr>
<td>5481 05-09-2012 JE60</td>
<td>IV000154</td>
<td>$1,772.00</td>
<td></td>
</tr>
<tr>
<td>06-12-2012 JE60</td>
<td>IV000163</td>
<td>$310.00</td>
<td></td>
</tr>
<tr>
<td>06-30-2012 JE35</td>
<td>IV000173</td>
<td>$707.40</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal:</strong></td>
<td></td>
<td>$2,789.40</td>
<td></td>
</tr>
<tr>
<td>6002 05-23-2012 JE60</td>
<td>IV000156</td>
<td>$2,662.71</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IV000157</td>
<td>$745.69</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IV000159</td>
<td>$2,938.37</td>
<td></td>
</tr>
<tr>
<td>06-06-2012 JE60</td>
<td>IV000161</td>
<td>$1,576.22</td>
<td></td>
</tr>
<tr>
<td>06-07-2012 JE60</td>
<td>IV000162</td>
<td>$1,566.44</td>
<td></td>
</tr>
<tr>
<td>06-12-2012 JE60</td>
<td>IV000166</td>
<td>$2,426.10</td>
<td></td>
</tr>
<tr>
<td>06-27-2012 JE60</td>
<td>J1204638</td>
<td>$1,192.25</td>
<td></td>
</tr>
<tr>
<td>06-30-2012 JE35</td>
<td>IV000169</td>
<td>$2,919.34</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal:</strong></td>
<td></td>
<td>$16,027.13</td>
<td></td>
</tr>
<tr>
<td>6004 06-07-2012 JE60</td>
<td>J1204258</td>
<td>$35.98</td>
<td></td>
</tr>
<tr>
<td>06-12-2012 JE60</td>
<td>J1204316</td>
<td>$56.61</td>
<td></td>
</tr>
<tr>
<td>06-14-2012 JE60</td>
<td>J1204406</td>
<td>$3.78</td>
<td></td>
</tr>
<tr>
<td>06-22-2012 JE60</td>
<td>J1204553</td>
<td>$34.13</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>$0.23</td>
<td></td>
</tr>
<tr>
<td>06-30-2012 JE60</td>
<td>J1204780</td>
<td>$8.42</td>
<td></td>
</tr>
<tr>
<td><strong>Subtotal:</strong></td>
<td></td>
<td>$139.15</td>
<td></td>
</tr>
</tbody>
</table>
Printing Month-End Financial Reports via ePrint

What is Banner ePrint?

The Office of Finance does not provide monthly budget reports to departments. Banner ePrint allows users to print monthly financial reports as soon as they are available – usually the first business day of the month. Please ensure that you see the message indicating that financial reports have been validated before using any budget reports via ePrint.

Employees who monitor and report on budget and payroll activity can obtain access to ePrint.

Access to departmental Payroll reports must be requested separately. To request access to Payroll reports in ePrint, complete this form:

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf

Before the access is granted, all users must attend Office of Finance ePrint training.

ePrint allows a user to view reports as a PDF (Adobe Portable Document Format) file which can be viewed via Adobe Reader or to download a CSV file into Excel. Keep in mind that when you download a CSV file, you must format the size of the columns to display all information.

You must have a Banner account with the appropriate access in order to use ePrint. When you log into ePrint, you will use your current Banner User ID and your Banner password.

https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi

Here is a screenshot of a sample budget report from ePrint.

See the appendix for the full documentation on ePrint. Documentation is provided to individuals who attend ePrint training.
Payroll Reports

The payroll reports contain information by budget unit, employee, and payroll number and are useful in determining each employee’s charge for a specific payroll and check date. The top of the form shows the reporting period covered (i.e., 01-JUL-2011 to 31-JUL-2011). Refer to the Payroll schedule, published annually, to determine the specific payroll number. The Banner payroll reports are available via ePrint each month. Contact Data Control at 683-3257 if you have questions about your Payroll reports.

Payroll reports are available via ePrint for those individuals who have the appropriate access (see previous page). Be sure to DRILL DOWN to see details.

PAYROLL REPORT MOCK-UP – Payroll reports are broken down by budget code, sub-object code, and employee.

<table>
<thead>
<tr>
<th>Fund</th>
<th>Orgn</th>
<th>Acct</th>
<th>Prog</th>
<th>Actv</th>
<th>Locn</th>
<th>ID/Name</th>
<th>EARNINGS Hours</th>
<th>EARNINGS Amount</th>
<th>BENEFITS Amount</th>
<th>Total Hours</th>
<th>Total Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>011001</td>
<td>1XX00</td>
<td>4001</td>
<td>161</td>
<td>*</td>
<td>*</td>
<td>12345678 EMPLOYEE, SUZIE Q</td>
<td>86.67</td>
<td>3,994.75</td>
<td>.00</td>
<td>86.67</td>
<td>3,944.75</td>
</tr>
<tr>
<td>2006 FT 311 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>23456789 WORKER, JAMES X</td>
<td>86.67</td>
<td>1,729.88</td>
<td>.00</td>
<td>86.67</td>
<td>1,729.88</td>
</tr>
<tr>
<td>Empl Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>86.67</td>
<td>3,994.75</td>
<td>.00</td>
<td>86.67</td>
<td>3,994.75</td>
</tr>
<tr>
<td>FYTD Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>86.67</td>
<td>1,729.88</td>
<td>.00</td>
<td>86.67</td>
<td>1,729.88</td>
</tr>
</tbody>
</table>
Resolving Budget Discrepancies (IDTs and Accounting Service Request)

The Office of Finance is responsible for researching and resolving errors when University departments discover inappropriate or unidentifiable expenditures against their budgets. There are two mechanisms available to departments.

- The IDT process should be used when you know specific correction information.
- The Accounting Service Request (ASR) process must be used to initiate research when you cannot identify why the charge was made to your budget.


Interdepartmental Transfers (IDTs)

IDT forms are prepared when financial accounting entries need to be recorded. Transactions for budget corrections, transferring charges (reimbursing) to other departments and recording expense charges are examples of why IDTs are processed.

IDT forms are located on the Office of Finance web site under Faculty/Staff forms. The forms are fillable PDF forms and can be saved to your computer. Completed forms must be signed, scanned, and e-mailed to IDTs@odu.edu

The form must be completed as follows:

- All fields in both the charge and credit information areas must be completed
  - Charge information
    - Organization/account
    - Department name
    - Contact name
    - Contact phone
    - Authorized signature
  - Credit information
    - Organization/account
    - Department name
    - Contact name
    - Contact Phone
    - Authorized Signature
  - Accounting Distribution for Charge (Fund, Org, Sub-Account, Amount)
  - Accounting Distribution for Credit (Fund, Org, Sub-Account, Amount)
- An explanation must be provided, including any applicable document reference numbers.
• Supporting documentation must be included and must be clear and concise. Backup documentation can include:
  o Printed Banner reports
  o Screen prints from Banner
  o E-mail correspondence
  o Invoices
  o Notes or memos
  o Tear sheets, ad copies or publications
  o Transportation or event tickets
  o Receipts
  o Other materials relating to the entries

• Debit amounts must match the credit amounts

• If original charge noted, this indicates that the transaction is a charge from one department to another and the supporting documentation should show the goods and services that were provided.

• If correction of charge is noted, this indicates that the transaction is for one department to reimburse another department, and the supporting documentation must show the original transaction in Banner where the department being reimbursed was originally charged.

• The IDT continuation sheet should be used as needed.

All transactions must be thoroughly supported by documentation explaining the need for the action, including attaching all applicable Banner screenshots. Appropriate approval signatures are required for all budget units affected and the preparer's contact information must be included in case there are questions about the requested transactions.

IDT transactions show up in Banner as a JE35 (within the same fund) or JE60 (between funds) journal entry.

**Submitting the IDT:**

Completed forms must be signed, scanned, and e-mailed to IDTs@odu.edu

Ensure that you have included supporting documentation in your e-mail.
### OLD DOMINION UNIVERSITY
INTERDEPARTMENTAL TRANSFER REQUEST
(E-mail signed/scanned form to IDTs@odu.edu).

<table>
<thead>
<tr>
<th>CHARGE (ORG/ACCT)</th>
<th>CREDIT (ORG/ACCT)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Authorized Signature**

#### Accounting Distribution for Charge

<table>
<thead>
<tr>
<th>FUND</th>
<th>ORG</th>
<th>SUB ACCOUNT</th>
<th>AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Authorized Signature**

#### Accounting Distribution for Credit

<table>
<thead>
<tr>
<th>FUND</th>
<th>ORG</th>
<th>SUB ACCOUNT</th>
<th>AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Additional accounting distribution sheets attached
- Original Charge – attach supporting documentation
- Correction of Charge – attach Banner documentation

**Explanation of Transfer:**

---

**FOR ADMINISTRATIVE USE ONLY**

Processed by: ______________________

Date: ______________________ Rev. July 18, 2013
### OLD DOMINION UNIVERSITY
### INTERDEPARTMENTAL TRANSFER REQUEST
(E-mail document with signed/scanned page 1 of IDT form to IDTs@odu.edu).

<table>
<thead>
<tr>
<th>DEBIT: Accounting Distribution</th>
<th>CREDIT: Accounting Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>FUND</td>
<td>ORG</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Revised July 18, 2017*
Accounting Service Request (ASR)

The ASR process is used to research charges. Coding corrections must be submitted using an Interdepartmental Transfer (IDT) form.

1. As you reconcile your budget, unidentifiable charges need to be researched and resolved. Review your budget transactions through the Organization Budget Status Form (FGIBDST).

2. If you find unidentifiable charges, complete an Accounting Service Request (ASR) form (available from the following web page) with the following information.
   a. Date
   b. Department Name
   c. Contact Name (Person preparing the form)
   d. Telephone number
   e. E-Mail address
   f. Details of research requested:
      - Fiscal year
      - Original Doc # in Banner
      - Dollar Amount
      - Notes to assist research

3. Please keep a copy of this form and e-mail the completed PDF form to DataControlASR@odu.edu. Be sure to include screenshots of all back-up documentation.

4. When the ASR form and documentation are received, the Data Control Representative reviews the form and documentation.
   a. If any information or documentation is missing, to the department will be contacted outlining what additional information is required.

5. If all information and documentation is complete, the form is processed.

6. A reference number is assigned to the ASR, and that number is returned to the department via e-mail. Please use the reference number when following up on the problem. Data Control is responsible for monitoring and tracking problem resolution.

7. The original ASR form and supporting documentation are forwarded via e-mail to the appropriate area in the Office of Finance for research and resolution.
8. When the problem has been resolved or the charge identified, the department is notified of the action taken to resolve the issue. The correcting entry will be posted to your budget via a journal entry. On FGITRND, the description will contain the ASR number.

9. Response times can vary, depending on the research required. Generally, most issues can be resolved within 14 work days.

10. Questions about the status of specific Accounting Service Requests should be directed to DataControlASR@odu.edu. Please reference the assigned number in any correspondence.
ACCOUNTING SERVICE REQUEST FORM (ASR) revised 07/18/2013

Research and document activity (attach appropriate screen prints from Banner)

Departmental Use – complete all sections – incomplete forms will be returned.
The ASR process is used for researching activity.
Coding corrections must be submitted using an Interdepartmental Transfer (IDT) form.

<table>
<thead>
<tr>
<th>Date</th>
<th>Department</th>
<th>Telephone #/e-mail</th>
</tr>
</thead>
</table>

Provide full details regarding the research requested.

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Original Doc # in Banner</th>
<th>Dollar Amount</th>
<th>Notes to assist research</th>
</tr>
</thead>
</table>

Action Requested - Be specific and provide the appropriate back-up documentation. ASRs without back-up documentation will be returned without action.

<table>
<thead>
<tr>
<th>Justification/Reason</th>
</tr>
</thead>
</table>

Additional information concerning your request that would assist us in error correction or researching/documentation.

- Submit the completed ASR form and required support documentation via e-mail to DateControlASR@odu.edu. Keep copies for your files.
- E-mail date is submission date. (E-mails received after 2:00pm will be considered received on the next work day.)
- Average processing time – 14 business days.
- Questions about the ASR process may be addressed to DateControlASR@odu.edu or 757-683-3257. Please reference the assigned ASR number.
- The ASR number is reflected in Banner when corrections posted in Banner.

** Office of Finance Use Only Below This Line **

<table>
<thead>
<tr>
<th>Reference #</th>
<th>Date Processed</th>
<th>Assigned to:</th>
</tr>
</thead>
</table>

| Problem Type | |

<table>
<thead>
<tr>
<th>Response Section – completed by department assigned to resolve/research.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Date Received</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Name of Person Responding</th>
<th>Department</th>
</tr>
</thead>
</table>

Part of the Certificate in University Financial Management, revised February 16, 2017
PART I: MULTIPLE CHOICE. DIRECTIONS: Circle the correct response(s).

1. Fund transfers move cash from one fund to another and are classified as
   a. Emergency and non-emergency
   b. Mandatory and nonmandatory
   c. Transferable and nontransferable
   d. All of the above
   e. None of the above

2. A budget adjustment within a single org unit that requests an increase of $50,000 must be approved by
   a. The President
   b. The Vice President for Administration and Finance
   c. The Budget Office
   d. The Dean or Director

3. All gift funds should be initially be deposited where?
   a. The Cashier’s Office
   b. The regular E&G budget for your department
   c. The departmental discretionary budget
   d. The Educational or Intercollegiate Foundation, as appropriate
   e. None of the above

4. A budget adjustment between org units that requests an increase of $20,000 must be approved by
   a. The President
   b. The respective Deans/Directors and Vice Presidents/Executive Officers
   c. The Vice President for Administration and Finance
   d. The Provost

5. What statements are true about Interdepartmental Transfers?
   a. All fields in both the charge and credit information areas must be completed.
   b. An explanation must be provided.
   c. Supporting documentation must be included and be clear and concise.
   d. Backup documentation can include Banner screen prints.
6. What Banner form is used to check the available balances at the pool account level for Benefits, Nonpersonal Services, Travel, and Equipment and at the detailed level for personal services for your departmental budget?
   a. Organization Budget Summary Form (FGIBSUM)
   b. Organization Budget Status Form (FGIBDST)
   c. Budget Availability Status Form (FGIBAVL)
   d. Detail Transaction Activity Form (FGITRND)

7. What Banner form is used to view the budget and expenditure totals by line item?
   a. Organization Budget Summary Form (FGIBSUM)
   b. Organization Budget Status Form (FGIBDST)
   c. Budget Availability Status Form (FGIBAVL)
   d. Detail History Form (FAIVNDH)

8. What Banner form is used to show a summary of budget information by revenue, total personal and nonpersonal services, and transfers for a specific budget?
   a. Organization Budget Summary Form (FGIBSUM)
   b. Organization Budget Status Form (FGIBDST)
   c. Budget Availability Status Form (FGIBAVL)
   d. Detail History Form (FAIVNDH)

9. If you have insufficient funds available in your budget because an expenditure was posted to the incorrect sub-account, what action should you take?
   a. Process a budget adjustment to increase the budget in the sub-account affected.
   b. Request error correction from the Office of Finance by sending an IDT form and supporting documentation.
   c. Request that Accounts Payable override the insufficient funds message.
   d. Do nothing and hope the problem will resolve itself.

10. If you wish to do business with a vendor and can’t locate a vendor number in Banner, which office do you contact for assistance?
    a. Procurement Services
    b. Budget Office
    c. Accounts Payable
    d. Accounts Receivable
    e. The vendor supplying merchandise
PART II: TRUE OR FALSE
DIRECTIONS: Please answer TRUE (T) or FALSE (F) for each of the following responses:

1. If the Banner Organization Budget Status Form (FGIBDST) shows a negative balance available in office supplies (6002), your next attempt to order office supplies with a purchase order will reject.

2. Federal workstudy student funds can be transferred to cover other operating expenses.

3. The document number on the Detailed Transaction Activity Form (FGITRND) is assigned by the Budget Office.

4. There is no way for departments to research invoices without the assistance of Accounts Payable.

5. Budget adjustments should be used to correct expenditures charged to the wrong budget.

6. You can research detailed transactions through the Budget Availability Status Form (FGIBAVL).

7. Budget Unit Directors are required to monitor budgets to ensure there are no unexplained variances.

8. The budget adjustment form is used to request changes to the current operating budget, the base budget, or both, within existing policies and procedures.

9. Budget adjustments within a single org unit of $100,000 must be approved by the Dean/Director plus the respective Vice President/Executive Officer.

10. Use of the remarks section on the budget adjustment form is optional.

11. To review detailed information about a specific encumbrance, use the Detail Encumbrance Activity Form (FGIENCD).

12. There is no way to view encumbrance details once an invoice has been paid and the purchase order is liquidated.

13. A vendor cannot be paid if there are insufficient funds, even when the encumbrance has reserved the funds.

14. You can view the vendor payment history in Banner.

15. The accrual period is referred to as the 13th month.
16. Old Dominion University is on the cash basis of accounting.

17. The budget transaction code in Banner that indicates original budget load is BD01.

18. The budget transaction code in Banner that indicates budget adjustment activity in Banner is BD02.

19. An interdepartmental transfer can be used to move expenditures from one budget to another.

20. Before recruiting for a vacant faculty, faculty administrator or faculty professional position outside of Academic Affairs, the request must be reviewed by Human Resources and approved by the President.

ANSWERS TO SAMPLE TEST

PART I -- MULTIPLE CHOICE

1. b
2. d
3. d
4. b
5. a, b, c, d
6. c
7. b
8. a
9. b
10. c

PART II -- TRUE OR FALSE

1. False
2. True
3. False
4. True
5. False
6. True
7. False
8. True
9. True
10. False
University Budget Office

Mission
The University Budget Office provides the primary support and analyses to University leadership in fiscal and budgetary policy development to promote attainment of the University's mission and strategic plan. The Budget Office strives to implement sound budget and management practices in a collegial fashion with the University community and the Commonwealth of Virginia. Collaboratively, the University aspires to prudent resource allocation, public accountability, and creative, proactive 21st century education.

Methods
The University Budget Office is dedicated to assisting University staff in the establishment, maintenance, and prudent oversight of budgets, providing training, financial and statistical information and analyses. We are committed to "customer service" and engaging and responding to our many public stakeholders.

Primary Functions
- Coordinate all facets of the University’s state budget preparation process.
- Administer University Budget and Financial Management Policy.
- Manage the University Operating Budget Plan and monitor for conformity with requirements of the Commonwealth of Virginia’s Department of Planning and Budget (DPB), the State Council on Higher Education (SCHEV), the Auditor of Public Accounts, and numerous other state and federal requirements.
- Manage both the budgeting and accounting for capital projects (new buildings and major renovations).
- Coordinate the budgeting process for auxiliary enterprises and the approval process for supporting revenue plans.
- Collaborate with Human Resources in the many dimensions and requirements of "position control" comprising 80% University budget resources.
- Conduct budget feasibility and execution analyses and monitor institutional performance measures.

Overview & Management
- Budget At A Glance
- Budget Management
- Capital Projects

Budget Development
- Commonwealth Biennial Budget
- Budget Planning, Process & Timeline
- Operating Budget Instructions

Budget Resources
- Banner Financial Access
- Banner Training

Find sub-account listings here
OPERATING BUDGET INSTRUCTIONS

http://www.odu.edu/facultystaff/university-business/budget/development/instructions
DOWNLOADING BUDGET INFORMATION FROM BANNER

Departments can now download select budget data into Excel spreadsheets. This provides departments with another tool to more effectively manage budgets. This download process should not be confused with the Cognos budget reports available via Insight. You can only download data for budgets to which you have Banner access. You may not have access to all forms listed in this handout if they are not included in your current Banner access. Once you have set up your output options that determine where you want your Excel files stored, you can download information.

Set up your output options

Before you can download from Banner, you must first tell Banner where you would like your output (Excel file) stored. You do that in the General User Preferences Maintenance form (GUAUPRF) which can be accessed from the File pull-down menu (click on Preferences from the file pull-down menu).

After you click on the File pull-down menu, select Preferences.
Determining where data will be stored

Select the second tab entitled “Directory Options.”

The top description is “Local directory for saving output.” The default location, or value, where files are stored is `c:\temp`. **User Value** can be changed to reflect where you want your Excel output to be stored, i.e., `h:\backup`. That is the only thing you should change – leave everything else as it defaults, **unless you have made changes to your settings (see next page).**
Be sure that **FILE** displays as both the default value and user value for the data extract format. If you have changed those settings, they must be set to **FILE** in order to download data. Enter the **User Value** where you want your files stored (under Local directory for saving output). Click **Save**. You will see the message that the transaction is complete and you can exit from GUAUPRF (General User Preferences Maintenance form).
The following forms contain select information that can be downloaded from Banner into a basic Excel spreadsheet. Once you have set up where you want your Excel files to be stored, you can download information into a generic Excel spreadsheet. *Remember, what you can download depends on your Banner access.*

For the following forms, from the *Help* pull-down menu – select “*Extract Data with Key.*”

<table>
<thead>
<tr>
<th>Form Name</th>
<th>Descriptive Name</th>
<th>Info Contained</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FGIBAVL</td>
<td>Budget Availability</td>
<td>Summary data at org level</td>
<td>Shows line-item sub-accounts and pool accounts</td>
</tr>
<tr>
<td>FGIBDSR</td>
<td>Executive Summary</td>
<td>Summary budget data at any org level, including fund</td>
<td></td>
</tr>
<tr>
<td>FGIBDST</td>
<td>Organization Budget</td>
<td>Summary budget data at org level</td>
<td>Shows all sub-accounts</td>
</tr>
<tr>
<td>FGIBSUM</td>
<td>Organization Budget</td>
<td>Summary by account type</td>
<td></td>
</tr>
<tr>
<td>FGIDOCR</td>
<td>Document Retrieval</td>
<td>Transaction detail for any completed document</td>
<td></td>
</tr>
<tr>
<td>FGIENTCD</td>
<td>Detail Encumbrance</td>
<td>Contains encumbrance detail – shows payee, vendor number, coding and amounts – downloads header, encumbrance number and accounting distribution only</td>
<td>Vendor number DOES NOT download to Excel. Individual transactions do not download.</td>
</tr>
<tr>
<td>FGJSUM</td>
<td>Journal Voucher</td>
<td>Shows incomplete journal entries</td>
<td>For use with incomplete journal vouchers only.</td>
</tr>
<tr>
<td>FGIOENC</td>
<td>Organizational Encumbrance</td>
<td>Shows open encumbrances by number, payee and amount – no vendor numbers</td>
<td></td>
</tr>
</tbody>
</table>

For the following forms, from the *Help* pull-down menu - select “*Extract Data No Key.*”

<table>
<thead>
<tr>
<th>Form Name</th>
<th>Descriptive Name</th>
<th>Info Contained</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FGIENTCB</td>
<td>Encumbrance List</td>
<td>Shows encumbrance list by number, amount and date – no vendor numbers</td>
<td>WARNING – do not try to download the entire list – it is too large.</td>
</tr>
</tbody>
</table>

**DOWNLOADING TO EXCEL** – access the Banner form you want to download, populate the form, and select the appropriate extract key from the *Help* pull-down menu.
You are now prompted to open or save the file. Note the default file name. You will want to change this when you save.

- Open the file if you want to work with it immediately.
- Save the file if you want to save it and work with it later.
- Cancel to stop the download process.
When you wish to save the file, name your file and save it. You may choose another location for your file to be stored.

When you open the file, you will note that all columns are the same size – you can modify the spreadsheet formatting to suit your needs. When retrieving the file in Excel, you may need to change the file type to “all files” to locate the new file in the file list.

PROBLEMS

Please send questions, concerns or problems to bannerhotline@odu.edu.
APPENDIX – INSIGHT BUDGET REPORTING

The most recent documentation is always contained on-line at insight.odu.edu.
Table of Contents (page numbers from original document re:Insight)

DATA REFRESH/UPDATE TIMES........................................................................................................... 4

SECURITY: FUND ORG SECURITY ........................................................................................................ 4

DATA DEFINITIONS .............................................................................................................................. 5

DIRECTORY LAYOUT ............................................................................................................................ 7

BUDGET REPORT NAMES, PURPOSES, PROMPT SCREENS ............................................................... 8
CBB (Current Base Budget) by Budget Code by Revenue/Expenditure Category Rollups ..................... 8
CBB (Current Base Budget) by Budget Code by Revenue/Expenditure Category by Subaccounts ....... 9
CBB (Current Base Budget) by VP Area ............................................................................................... 10
CBB (Current Base Budget) by VP Area by Revenue/Expenditure Category .................................................................................. 11
CBB (Current Base Budget) by VP Area by Revenue/Expenditure Category by Subaccounts ......... 12
CBB by Revenue/Expenditure Category Across by Subaccounts (w Divisional Subtotals & Totals) ....13
COB (Current Operating Budget) by Revenue/Expense/Transfers (FGIBDST) ................................ 14
COB (Current Operating Budget) by Revenue/Expense/Transfers by Subaccount (FGIBDST) ......... 15
Current Operating Budget Revenue Report ......................................................................................... 16
Fund Code by Current Operating Budgets .......................................................................................... 17
Auxiliary Fund Rollup ........................................................................................................................... 18
Negative Budget Balances Report - by Budget Code/Hierarchy ............................................................ 19
Negative Budget Balances Report - by VP Area .................................................................................. 20
Subaccount(s) Specific Report ........................................................................................................... 21
Budget Transactions Matrix Report (FGITRND) ............................................................................... 22
YTD Ledger Rollup .................................................................................................................................. 23
Current Operating Budget (COB) by College/Division Report (FGIBDST) ......................................... 24
Current Operating Budget (COB) by College/Division by Budget Report (FGIBDST) .................... 25
COB by College/Division Subaccount Detail & Composite Report (FGIBDST) .............................. 26
My Budget List ....................................................................................................................................... 27
Base Budget Trends ............................................................................................................................. 28
Operating Budget Revenue Trends ....................................................................................................... 29
Operating Budget Trends ..................................................................................................................... 30
Revenue Expenditure Net Trend ........................................................................................................... 31
E&G Year End Budget Trends by FY by College/Division .................................................................. 32
Subaccount Detail and Composite Report ........................................................................................... 33

LIST OF REPORTS THAT ACCESS OTHER REPORTS ............................................................................ 34
INSIGHT AND ODS SERVICE ACTIVATION FOR REPORT ACCESS .................................................... 35
HOW TO MODIFY INTERNET EXPLORER OPTIONS FOR EXCEL .................................................... 35
HOW TO OUTPUT INFORMATION IN PDF, EXCEL (2002 & 2007) ................................................... 37
BUDGET MANAGEMENT AND FINANCIAL REPORTING

METHODS TO ADD A BUDGET TAB TO YOUR ACCOUNT ........................................ 41
Method One ........................................................................................................... 41
Method Two .......................................................................................................... 45
INFORMATIONAL NOTICES .................................................................................. 50
Data Refresh/Update Times

Finance data which is used for reporting using Cognos is read from ODS. ODS is Operational Data Store which is a Sungard product.

ODS is created using data available in Banner database. After initial load of banner data in ODS, ODS is refreshed from Banner on regular frequency. Currently we refresh the data in ODS on daily basis. Data is refreshed between Midnight and 6 AM every day. Refresh picks up all the changes in banner since last refresh and performs an ETL (Extract, Transform and Load) process on the data and makes it more useful and user friendly for reporting purposes. Please contact BI team at insight@odu.edu if you would like to get more detailed understanding on the process and timings or if you have any questions about Cognos reporting. For data related issues please contact Budget Office.

Security: “Fund Org” Security

Banner security currently allows users access to only those budget codes and fund codes within their realm of responsibility. Insight functions the same way: you only have access to the budget and fund codes which you are authorized to query in Banner.
Data Definitions

**Account Description 1**: A rollup category description of similar subaccounts (Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Revenues Categories)

**Adjustments**: Changes made to the base/operating budget on a year-to-date basis.

**Balance**: Computed total of Current Budget minus year-to-date activity and pending encumbrances.

**Base Budget**: Annualized budget that can change during the course of an operating budget year, may be modified during the budget process, and then rolls into operating for the ensuing operating year. Sometimes referred to as the ‘Original Budget’ at the start of the operating budget year.

**Budget Code**: 5 digit code that indicates a particular budget (1ED00 for Dean, College of Education).

**College/Division**: Lists the hierarchical grouping of colleges/divisions throughout the VP Areas (i.e., College of Business, College of Science, Recreational Sports, Facilities Management).

**Current Budget**: The calculation of the original base budget plus year-to-date budget adjustments.

**Debt Service**: Principle and interest payments tracked in subaccounts 9951 and 9952.

**Encumbrances**: Budget obligations/commitments for goods/services which have been procured (i.e., pending equipment orders). When a purchase order is issued, the funds for the purchase must be reserved. The process of reserving the funds is referred to as encumbrance. Once funds are encumbered, they are removed from the balance available. This prevents over-expenditures from occurring.

**Equipment**: Budget category rollup of equipment subaccounts between 9000 and 9899.

**Expenditures**: Refers to the actual funds expended. When a vendor bill is paid, it becomes an expenditure.

**Expense**: sum of categorical account groups (Personnel, Fringe Benefits, NPS, Travel, Equipment).

**Fiscal Year**: Period of time for accounting that starts on July 1 of a calendar year and ends on June 30 of a calendar year.

**Fringe Benefits**: Budget category rollup of fringe benefit line items such as Social Security, Retirement, Health Insurance subaccounts between 4900 and 4999.
**Fund**: Unique grouping of budget(s) segregated for specific purposes, costing and revenue support.

**Fund Code**: 6 digit number indicating the particular fund, i.e., 011001 = E&G

**Ledger**: Large grouping of budget codes/fund codes that generally reflect the “color of money”.

**Net**: Revenues minus expenses.

**NPS**: Budget category rollup of nonpersonal service line items such as skilled services, utilities, etc. subaccounts between 5000 and 6999.

**Organization Code**: same as Budget Code.

**Personnel**: Budget category rollup of Personnel line items such as classified salaries, wages, GTA’s, etc. subaccounts between 4000 and 4799.

**Revenue**: Budget category rollup of Revenue line items such as tuition, lab fees, health fees, athletic event fee subaccounts between 3000 and 3999.

**Sub-Account**: 4 unique digit code for each itemized revenue or expenditure or transfer line-item.

**Sub-Account Description**: A description of the sub-account line-item category, generally including what it consists of (tuition for a specific item, fees for a specific item, GTA’s, etc.).

**Transfers**: Budget category rollup of Transfer line items such as transfers to scholarships, transfer to auxiliary subaccounts between Accounts that are between 9900 and 9949. The act of moving money from one fund to another. Fund transfers are accounting transactions that move cash from one fund to another and are classified as mandatory (arising from binding legal agreements) and non-mandatory (agency discretion).

**Travel**: Budget category rollup of Travel line items subaccounts between 7000 and 7999.

**YTD**: Abbreviation for Year-To-Date activity.
Directory Layout

Base Budgets:
1: CBB by VP Area
2: CBB by VP Area by Revenue/Expenditure Category
3: CBB by VP Area by Revenue/Expenditure Category by Subaccounts
4: CBB by Budget Code by Revenue/Expenditure Category Rollups
5: CBB by Budget Code by Revenue/Expenditure Category by Subaccounts
6: CBB by Budget Code by Revenue/Expenditure Category Across by Subaccounts
   (w/Divisional Subtotals & Totals)
7: Base Budget Trends Report

Current Budget Reports:
1: COB by Revenue Expenditure Category Rollups
2: COB by Revenue/Expense/Transfers
3: COB by Revenue/Expense/Transfers by Subaccount
4: Current Operating Budgets by College/Division by Budget Report
5: Current Operating Budgets by College/Division Report
6: Current Operating Budgets by College/Division with Subaccount Detail & Composite Report
7: Current Operating Budget Revenue Report
8: YTD Ledger Rollup Report

Fund Code/Auxiliary:
1: Fund Code by Current Operating Budgets Report
2: Auxiliary Fund Rollup Report Budget

Current Budget Balances:
1: Negative Budget Balances Report by VP Area
2: Negative Budget Balances Report by Budget Code/Hierarchy

Transactions/Subaccounts:
1: Subaccount(s) Specific Report
2: Budget Transactions Matrix Report

Budget Trends:
1: Operating Budget Revenue Trends Report
2: Operating Budget Trends Report
3: Revenue Expenditure Net Trends Report
Budget Report Names, Purposes, Prompt Screens, Sample Output Reports

**CBB by Budget Code by Revenue/Expenditure Category Rollups**

Purpose: This report provides the most current (active base budget) typically used to evaluate permanent budget actions and to plan for next year’s operating budget. Displays current base budget (based on organizational hierarchy and your access) by total revenue and Expense Categories, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers. Allows drilldown to Budget Units.

---

*All university users are reminded of the University’s Code of Ethics and Policies regarding the protection and safeguarding of institutional data. As such, this data report pertains to University business and operations and is considered an institutional asset to be protected and used only in employees’ official conduct of their professional responsibilities.*
CBB by Budget Code by Revenue/Expenditure Category by Subaccounts

Purpose: This report provides the most current (active base budget) typically used to evaluate permanent budget actions and to plan for next year's operating budget. Displays current base budget by Revenue and Expense Categories by Subaccounts.
**CBB by VP Area**

Purpose: This report provides the most current (active base budget) typically used to evaluate permanent budget actions and to plan for next year’s operating budget. Displays current base budget by VP Area by College Division by Total Revenue and Expense/Transfers. Allows drilldown by Division to Budget Units.
**CBB by VP Area by Revenue/Expenditure Category**

Purpose: This report provides the most current (active base budget) typically used to evaluate permanent budget actions and to plan for next year’s operating budget. Displays current base budget by VP Area by College Division by Total Revenue, Expenditure Categories and Expense/Transfer Total. Allows drilldown by Division to Budget Units.
CBB by Budget Code by Revenue/Expenditure Category by Subaccounts

Purpose: This report provides the most current (active base budget) typically used to evaluate permanent budget actions and to plan for next year’s operating budget. Displays current base budget by Revenue and Expense Categories by Subaccounts.
CBB by Revenue/Expenditure Category Across by Subaccounts (w Divisional Subtotals & Totals)

Purpose: This report provides the current (active base budget) typically used to evaluate permanent budget actions and to plan for next year’s operating budget. Displays current base budget by Revenue and Expense Categories across and details by Subaccounts. Utilizes multiple parameters and enables divisional and budget categorical subtotals and totals of data.
COB by Budget by Revenue/Expense/Transfers (FGIBDST)

Purpose: This report provides the most current (operating budget activity report) typically used to evaluate year-to-date activity, encumbrances, and balances and to manage available resources accordingly. Rolls up to revenue, expense/transfers. Allows drilldown to COB by Revenue/Expenditure Category Rollups or Revenue/Expenditure/Transfer Category by Subaccounts.
COB by Budget by Revenue/Expense/Transfers by Subaccount (FGIBDST)

Purpose: This report provides the most current (operating budget activity report) typically used to evaluate year-to-date activity, encumbrances, and balances and to manage available resources accordingly. Displays data by budget categories: Personnel, Fringes, NPS, Travel, Equipment, Transfers, and then by Subaccounts.
**Current Operating Budget Revenue Report (FGIBDST)**

Purpose: This report provides the most current (operating budget REVENUE activity report) typically used to evaluate year-to-date revenue collected/deposited, and balances to attain budgeted revenues.

---

### Current Operating Budget Revenue Report

| Fiscal Year: | 2011 |
| VP Area:    | All  |
| College Division: | All |
| Fund Code:  | 021702 - HEALTH SERVICES |
| Budget Code:| All |

#### Current Operating Budget Revenue

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
<th>Budget</th>
<th>Adjustments</th>
<th>Current Budget</th>
<th>YTD</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>3884</td>
<td>STUDENT HEALTH FEES</td>
<td>$1,727,197.00</td>
<td>$24,359.00</td>
<td>$1,751,556.00</td>
<td>($240.00)</td>
<td>$1,727,197.00</td>
</tr>
<tr>
<td>3895</td>
<td>HEALTH SERVICE</td>
<td>$5,000.00</td>
<td>$0.00</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
</tr>
<tr>
<td>3885</td>
<td>LAO TEST FEES</td>
<td>$140,476.00</td>
<td>$0.00</td>
<td>$140,476.00</td>
<td>$140,476.00</td>
<td>$140,476.00</td>
</tr>
<tr>
<td>3887</td>
<td>HOSPITALITY</td>
<td>$1,068.00</td>
<td>$1,510.00</td>
<td>$5,496.00</td>
<td>$2,442.25</td>
<td>$3,043.75</td>
</tr>
<tr>
<td>3892</td>
<td>INVESTMENT INCUMBET</td>
<td>$18,209.00</td>
<td>$0.00</td>
<td>$18,209.00</td>
<td>$18,209.00</td>
<td>$18,209.00</td>
</tr>
<tr>
<td>3896</td>
<td>MISCELLANEOUS-MEDICAL ATHLETIC</td>
<td>$16,000.00</td>
<td>$0.00</td>
<td>$16,000.00</td>
<td>$16,000.00</td>
<td>$16,000.00</td>
</tr>
</tbody>
</table>

**Total**  
$1,595,870.00 | $27,800.00 | $1,933,670.00 | $1,897,098.25 | $36,571.75 |

Date: Feb 8, 2011 11:22:09 AM
Fund Code by Current Operating Budgets Report

Purpose: This report provides the most current (operating budget activity report) typically used to evaluate revenue and expense year-to-date activity, encumbrances, and balances and to manage available resources accordingly. Details adopted budget, adjustments, current budget, YTD, encumbrances, remaining balances by budget category rollups and net.
Auxiliary Fund Rollup Report

Purpose: This report captures all Auxiliaries within one's hierarchy and provides the high level current budget by budget category rollups and net. Allows drilldown to the Fund Code by Current Operating Budgets Report.
**Negative Budget Balances Report (FGIBAVL) - by Budget Code/Hierarchy**

**Purpose:** This report provides the most current (operating budget activity report) typically used to evaluate year-to-date activity, encumbrances, and balances and to realign one’s budget to eliminate negative balances in controlled subaccounts (4000 series) vs. pool accounts (NPS, Travel, Equipment).
Negative Budget Balances Report (FGIBAVL) - by VP Area

Purpose: This report provides the most current (operating budget activity report) typically used to evaluate year-to-date activity, encumbrances, and balances and to realign one’s budget to eliminate negative balances in controlled subaccounts (4000 series) vs. pool accounts (NPS, Travel, Equipment).
Subaccount(s) Specific Report (FGIBDST)

Purpose: This report enables subaccount specific inquiries from the operating budget to examine discreet data needs. For instance, you may need to examine subaccounts 4022 and 4023 over the last five years. This report with the right combination of parameters satisfies such inquiries. This report, when using multiple fiscal years, is best exported to Excel where the data columns can be managed/hidden as needed.
Budget Transactions Matrix Report (FGITRND)

Purpose: This report enables a top to bottom accounting of all transactions occurring in a specific budget unit from budget load to budget adjustments to expenditures and encumbrances. Total Reconciliation Trail.
BUDGET MANAGEMENT AND FINANCIAL REPORTING

YTD Ledger Rollup Report (FBIBDST)

Purpose: This high level Operating Ledger report provides the operating budget activity report grouped by Ledgers 1 to 8 +++ typically used to evaluate revenue and expense year-to-date activity, encumbrances, and balances and to manage available resources accordingly.
Current Operating Budget (COB) by College/Division Report (FGIBDST)

Purpose: This VP Level report enables high level summaries of college/division budgets typically used to compare Original Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances and to manage available resources accordingly. Rolls up subaccount data to budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service, Total Expense, and Net. Has functional drilldowns to Budget Unit data.
Current Operating Budget Report (COB) by College/Division by Budget Report (FGIBDST)

Purpose: This VP Level report can be accessed directly or is a drilldown from the COB by College/Division Report. Enables budget level typically used to compare Original Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances and to manage available resources accordingly. Rolls up subaccount data to budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service, Total Expense, and Net.
(COB) BY COLLEGE/DIVISION SUBACCOUNT DETAIL & COMPOSITE REPORT (FGIBDST)

Purpose: This report enables detailed budget unit reports by college/division comparing Original Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances by budget by subaccount level and budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service. Also Recaps Ledger/Color of Money composite. All components can be downloaded to Excel enabling budget unit specific reports which can be supplemented with your fiscal year projections and aggregated for Divisional Reports.
My Budget List

Purpose: Simply run this report and you will be shown your userid, user name, and the fund codes and budget codes you have access to.

<table>
<thead>
<tr>
<th>USERID</th>
<th>USERNAME</th>
<th>FUND_CODE</th>
<th>FUND_DESC</th>
<th>ORGN_CODE</th>
<th>ORGN_DESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILEPOOL</td>
<td>Richard LeHool</td>
<td>011091</td>
<td>OVIEG CUR</td>
<td>1900</td>
<td>FACILITIES MGMT ADMIN &amp; SUPV</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1901</td>
<td>CLASSROOM UPGRADES</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1910</td>
<td>CUSTOMER SERV</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1912</td>
<td>PUBLIC SAFETY RELOCATION/RENOV</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1914</td>
<td>ALUMNI HALL RENOVATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1915</td>
<td>GARBAGE &amp; TRASH</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1916</td>
<td>GARBAGE &amp; TRASH - HOUSING</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1915</td>
<td>BUILDING MAINT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1916</td>
<td>STRUCTURAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1927</td>
<td>FAC MNT MECHANICAL/ELECTRICAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1938</td>
<td>HOUSING MAINTENANCE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1950</td>
<td>CARE &amp; MAINT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1951</td>
<td>CAMPUS BEAUTIFICATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1955</td>
<td>CLASSROOM FURNITURE MAINT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1965</td>
<td>EQUIP/SUPPLY SPT CENTER</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1980</td>
<td>SP MRO &amp; ALT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1982</td>
<td>PROJECT MANAGEMENT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1996</td>
<td>PLANNING/ESTIMATING</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1996</td>
<td>UTILITIES</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1996</td>
<td>HOUSING UTILITIES</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1970</td>
<td>MOTOR VEH POOL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1973</td>
<td>MOVING &amp; HAULING</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1980</td>
<td>RECYCLING</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1988</td>
<td>RAL MESA LAB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1999</td>
<td>GOB RELOCATIONS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>19A9</td>
<td>ODU MASTERS PLAN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>011008</td>
<td>ENERGY PERFORMANCE FUNDS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>011052</td>
<td>ENERGY PERFORMANCE FUNDS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>011024</td>
<td>MANVILLE TRUST-0207 FUNDS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>152014</td>
<td>MANVILLE TRUST-0207 FUNDS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>071013</td>
<td>ATHLETIC BUDGET MGMT GROUP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100014</td>
<td>ATHLETIC BUDGET MGMT GROUP</td>
</tr>
</tbody>
</table>
Base Budget Trends Report

Purpose: This report provides comparative base budget data over multiple fiscal years.
Operating Budget Revenue Trends Report (FBIBDST)

Purpose: This report enables the tracking of operating budget revenue trends data typically used to evaluate multiple fiscal years of budgeted to actual revenue collected/deposited. This report, when using multiple fiscal years, is best exported to Excel where the data columns can be managed/hidden as needed.
Operating Budget Trends Report (FGIBDST)

Purpose: This report enables the tracking of operating budget trends data typically used to evaluate multiple fiscal years of budgeted to actual expense. Displays data by budget categories: Personnel, Fringes, NPS, Travel, Equipment, Transfers, and then by Budget, YTD by Fiscal Year.
### Old Dominion University

#### Operating Budget Trends Report

**Fiscal Year:** 2011, 2010, 2009  
**VP Area Param:** All  
**College Division Param:** All  
**Fund Code Param:** All  
**Budget Code Param:** 1PP60 - UTILITIES

<table>
<thead>
<tr>
<th>Operating Budget Trends by VP Area/College Division &amp; Year</th>
<th>2009 Current Budget</th>
<th>YTD</th>
<th>2010 Current Budget</th>
<th>YTD</th>
<th>2011 Current Budget</th>
<th>YTD</th>
</tr>
</thead>
<tbody>
<tr>
<td>VP OF ADMIN AND FINANCE 40000 1PP60 UTILITIES NPS</td>
<td>$4,936,424.00</td>
<td></td>
<td>$4,404,515.47</td>
<td></td>
<td>$4,966,233.00</td>
<td></td>
</tr>
<tr>
<td>Transfers</td>
<td>$174,589.00</td>
<td></td>
<td>$174,580.00</td>
<td></td>
<td>$215,652.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$215,652.39</td>
<td></td>
<td>$215,652.00</td>
<td></td>
</tr>
<tr>
<td>Total for 1PP60</td>
<td>$4,791,003.00</td>
<td></td>
<td>$4,576,104.37</td>
<td></td>
<td>$5,181,875.00</td>
<td></td>
</tr>
</tbody>
</table>

*JDuffy*  
*Feb 8, 2011, 2:26:09 PM*
Revenue Expenditure Net Trend Report

Purpose: This report enables the tracking of operating budget Revenue and Expenditure/Transfer trends data typically used to evaluate multiple fiscal years of budgeted to actual activity.
### Revenue Expenditure Net Trend Report

**Old Dominion University**

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>2011, 2010, 2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>VP Area</td>
<td>All</td>
</tr>
<tr>
<td>College Division</td>
<td>All</td>
</tr>
<tr>
<td>Fund Code</td>
<td>011003 - CW CEPS FUND</td>
</tr>
<tr>
<td>Budget Code</td>
<td>All</td>
</tr>
</tbody>
</table>

#### Revenue/Expenditure Net Trends

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>2009</th>
<th>2010</th>
<th>2011</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sum Adopted Budget</td>
<td>$2,406,082.00</td>
<td>$2,731,534.00</td>
<td>$3,294,694.00</td>
<td>$9,862,909.00</td>
</tr>
<tr>
<td>Sum Budget Adjustments</td>
<td>$1,175,432.00</td>
<td>$945,299.00</td>
<td>$605,123.00</td>
<td>$2,745,854.00</td>
</tr>
<tr>
<td>Sum Accounted Budget</td>
<td>$3,777,225.00</td>
<td>$6,694,833.00</td>
<td>$6,995,862.03</td>
<td>$17,437,920.03</td>
</tr>
<tr>
<td>Sum Year to Date Activity</td>
<td>$3,491,653.33</td>
<td>$3,409,003.42</td>
<td>$3,003,657.25</td>
<td>$9,904,313.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personnel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sum Adopted Budget</td>
<td>$1,614,101.00</td>
<td>$1,881,987.00</td>
<td>$1,923,477.00</td>
<td>$4,416,877.00</td>
</tr>
<tr>
<td>Sum Budget Adjustments</td>
<td>$376,716.00</td>
<td>$211,235.00</td>
<td>$123,177.00</td>
<td>$711,128.00</td>
</tr>
<tr>
<td>Sum Accounted Budget</td>
<td>$1,991,817.01</td>
<td>$2,092,212.00</td>
<td>$2,041,659.03</td>
<td>$5,125,688.04</td>
</tr>
<tr>
<td>Sum Year to Date Activity</td>
<td>$2,082,116.21</td>
<td>$1,754,467.00</td>
<td>$1,564,727.00</td>
<td>$5,401,300.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fringe Benefits</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sum Adopted Budget</td>
<td>$335,446.00</td>
<td>$344,434.00</td>
<td>$367,644.00</td>
<td>$1,047,524.00</td>
</tr>
<tr>
<td>Sum Budget Adjustments</td>
<td>$66,101.00</td>
<td>$60,176.00</td>
<td>$31,404.00</td>
<td>$167,681.00</td>
</tr>
<tr>
<td>Sum Accounted Budget</td>
<td>$360,549.00</td>
<td>$385,310.00</td>
<td>$336,040.00</td>
<td>$1,088,905.00</td>
</tr>
<tr>
<td>Sum Year to Date Activity</td>
<td>$400,573.10</td>
<td>$355,550.61</td>
<td>$326,703.56</td>
<td>$1,083,827.60</td>
</tr>
</tbody>
</table>

#### Notes

- The report details the revenue and expenditure trends for Old Dominion University over the fiscal years 2009, 2010, and 2011.
- The data includes budgeted and actual figures for various financial categories.
- The grand total column provides a summary of the figures for each year.
E&G Year End Budget Trends by FY by College/Division

Purpose: This report enables a review of actual E&G expenditures by fiscal year trends determined by the user. Consistent with organizational hierarchy and Banner security access level, data can be rolled up to the college/division level and drilled down to the department level. For Academic Affairs year-end program reviews the data can display the personnel subaccount details while rolling up the fringe benefit, NPS, travel, and equipment categories.
### OLD DOMINION UNIVERSITY

#### E&G Year End Budget Trends by FY by College/Division

<table>
<thead>
<tr>
<th>Fiscal Year:</th>
<th>2011</th>
<th>2010</th>
<th>2009</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ACADEMIC AFFAIRS</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Personnel</strong></td>
<td>$9,966,331.28</td>
<td>$9,620,361.27</td>
<td>$9,351,691.93</td>
</tr>
<tr>
<td><strong>Fringe Benefits</strong></td>
<td>$2,685,323.38</td>
<td>$2,577,613.16</td>
<td>$2,290,026.09</td>
</tr>
<tr>
<td><strong>NPS</strong></td>
<td>$1,854,885.45</td>
<td>$1,188,907.88</td>
<td>$681,205.57</td>
</tr>
<tr>
<td><strong>Travel</strong></td>
<td>$220,127.91</td>
<td>$201,399.03</td>
<td>$120,299.95</td>
</tr>
<tr>
<td><strong>Equipment</strong></td>
<td>$295,706.68</td>
<td>$181,023.48</td>
<td>$239,027.80</td>
</tr>
<tr>
<td><strong>Transfers</strong></td>
<td>($195,408.00)</td>
<td></td>
<td>($1,301.00)</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$13,766,569.70</td>
<td>$13,765,683.64</td>
<td>$13,692,617.92</td>
</tr>
</tbody>
</table>

| **DEAN OF EDUCATION** | | | |
| **Personnel** | $9,905,331.28 | $9,610,361.27 | $9,351,691.93 |
| **Fringe Benefits** | $2,685,323.38 | $2,577,613.16 | $2,290,026.09 |
| **NPS** | $1,854,885.45 | $1,188,907.88 | $681,205.57 |
| **Travel** | $220,127.91 | $201,399.03 | $120,299.95 |
| **Equipment** | $295,706.68 | $181,023.48 | $239,027.80 |
| **Transfers** | ($195,408.00) | | ($1,301.00) |
| **Total** | $13,766,569.70 | $13,765,683.64 | $13,692,617.92 |

| **DEAN OF EDUCATION** | **COUNSELING & HUMAN SERVICES** | | |
| **Personnel** | $1,179,145.98 | $1,054,793.26 |
| **Fringe Benefits** | $214,756.65 | $367,631.82 |
| **NPS** | $50,345.97 | $30,646.92 |
Subaccount Detail and Composite Report

Purpose: This report enables detailed budget unit reports by college/division comparing Original Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances by budget by subaccount level and budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service for multiple fiscal years and multiple budgets. Also Recaps Ledger/Color of Money composite. All components can be downloaded to Excel enabling budget unit specific reports which can be supplemented with your fiscal year projections and aggregated for Divisional Reports.
## BUDGET MANAGEMENT AND FINANCIAL REPORTING

### OLD DOMINION UNIVERSITY

#### COB by College/Division Subaccount Detail & Composite Report (F9IBDST)

**Fiscal Year:** 2012, 2011  
**Budget Code:** 3M050 - STUDENT HOUSING

| Revenues | 2011 | Adjustments | Current Budget | YTD | Encumbrances | Remaining Balance | 2012 | Adjusted Budget | Adjustments | Current Budget |
|----------|------|-------------|----------------|-----|--------------|------------------|------|----------------|-------------|----------------|----------------|
| Auxiliary Sales (SAS) | | | | | | | | | | | |
| 3H01 - STUDENT REV (REV) | | | | | | | | | | | |
| 3H02 - STUDENT REV (REV) | | | | | | | | | | | |
| 3H03 - COMMERCIAL RENT | | | | | | | | | | | |
| 3H04 - PORTFOLIO-ROOM OPERATIONS | | | | | | | | | | | |
| 3H05 - CHARGES | | | | | | | | | | | |
| 3H06 - HOUSING APPLICATION FEE | | | | | | | | | | | |
| 3H07 - COMMISSIONS - NPSU | | | | | | | | | | | |
| 3H08 - MISCELLANEOUS ACTIVITIES | | | | | | | | | | | |
| **Grand Total** | | | | | | | | | | | |

| Expenditures/Transfers | 2011 | Adjustments | Current Budget | YTD | Encumbrances | Remaining Balance | 2012 | Adjusted Budget | Adjustments | Current Budget |
|-------------------------|------|-------------|----------------|-----|--------------|------------------|------|----------------|-------------|----------------|----------------|
| 3H01 - PERSONNEL | | | | | | | | | | | |
| 3H02 - CLASSIFIED SALARIES | | | | | | | | | | | |
| 3H03 - SALARIED PERSONNEL | | | | | | | | | | | |
| 3H04 - SALARIED-EXCEPTIONAL PERSONNEL | | | | | | | | | | | |
| 3H05 - MISCELLANEOUS PERSONNEL | | | | | | | | | | | |
| 3H06 - CLASS SURPLUS SALARY-HOLDING | | | | | | | | | | | |
| 3H07 - DED-RES CASH TRANSFER | | | | | | | | | | | |
| 3H08 - STUDENT SURPLUS | | | | | | | | | | | |

**Page 100**

Part of the Certificate in University Financial Management – revised October 25, 2016
Purpose: List of Reports That Access Other Reports

1. CBB by Budget Code by Revenue/Expenditure Category Rollups
   a. CBB by Budget Code by Revenue/Expenditure Category by Subaccounts

2. CBB by VP Area
   a. CBB by VP Area by Revenue/Expenditure Category
      i. CBB by VP Area by Revenue/Expenditure Category by Subaccounts

3. Fund Code by Current Operating Budget
   a. COB by Budget by Revenue/Expense/Transfers (FGIBDST)
   b. COB by Budget by Revenue/Expense/Transfers by Subaccount

4. Auxiliary Fund Rollup
   a. Fund Code by Current Operating Budget

5. Current Operating Budget (COB) By College/Division Report (FGIBDST)
   a. Current Operating Budget (COB) By College/Division by Budget Report (FGIBDST)
6. Activating Insight and Operational Data Store Services for Budget Report Access

1. Login to MIDAS at http://midas.odu.edu.
2. Review your Active Services under Account Details.
   a. Services Insight and Operational Data Store (ODS) must be under your Active Services to be able to access Budget Reports.
   b. If you do not see these under your Active Services, click on the Inactive Services tab. Locate the Insight and/or Operational Data Store (ODS) options and click on one.
   c. Click on the button “Click to Activate Service”.
   d. Verify you receive the message “Service successfully activated”.
   e. Click the link “Back to Account Information”.
   f. Verify that the service you selected is in your Active Services list.
   g. Perform actions b through f to add the other service you may not have.
How To Modify Internet Explorer Options to allow Excel formatted output.

7. Open Internet Explorer
8. Click on Tools -> Internet Options
9. Click on Security tab
10. Click on Internet
11. Click on Custom Level
12. Ensure that the Automatic Prompting for File Downloads and File Download are enabled.
13. Click OK
14. Repeat the same for Intranet and Trusted Sites options as well.
15. Close the browser and run the report.
16. You may need to allow popups from this website. To do this, go to Tools -> Pop-up Blocker -> Pop-up Blocker Settings. In the box labeled Address of website to allow: input insight.odu.edu. Click the Add button on the right hand side of the box, and then click Close.
How To Output Information in PDF, Excel 2002 and 2007 versions. If you have Excel 2010, it will open if you select the 2007 version.

Once a report has been run, and you are able to view output, you can click on the Output button’s drop down arrow in the top right hand corner.

A menu will appear, allowing you choices of how you would like to view the output.

Clicking on “View in PDF Format” will output the same data you see in a PDF file.
Clicking on the “View in Excel Options” provides a drop down allowing you to choose various Excel format options. Click the one that you would like to view.

Click the one that you would like to view. A pop up will appear. You have the option to save or view.
Clicking on “Open” reveals the data in an Excel spreadsheet.

Clicking on “Save” will display another pop up, asking you for the filename and directory where you would like to save the file.
Methods to Add a Budget Tab to Your Account

Method One

1. Click the area button towards the left hand corner and click on My Preferences menu item, and then click the Portal Tabs tab. A list of your current tabs appears.
2. Click **Add**.
3. In the list of available pages, select the page you want. You can select multiple pages. Click Public Folders.
4. Click Access Pages.

5. Click Budget Tracking. Click the right arrow button to move the page to the Selected entries box.

6. Click OK. The tab for the page appears in the portal.
7. Click Ok. The Budget Tracking tab appears on your menu.
Method Two

1. From the tab menu on the left side of the tab bar, click Add tabs.
2. In the list of available pages, select the page you want. You can select multiple pages. We will select Public Folders.

4. Click Budget Tracking. Click the right arrow button to move the page to the **Selected entries** box.
5. Click **OK**. The tab for the page appears in the portal.

6. Click Ok. The Budget Tracking tab appears on your menu.
Informational Notices

If you receive the following screen(s), this means you do not have the access for the prompt choices made or no data exists for that combination.
Printing Financial Reports
(Budget and Payroll Month-End)
via ePrint

TRAINING REQUIRED BEFORE ACCESS IS GRANTED
Table of Contents

What is Banner ePrint? .................................................................................................................. 3
What Do You Need to Get Started? ................................................................................................. 4
ePrint Payroll Report Request Form ............................................................................................... 5
How Do You Access Banner ePrint? ................................................................................................. 6
Repository Messages/Notifications ................................................................................................. 7
When You First Log In ..................................................................................................................... 8
Drilling Down to Select a Report ...................................................................................................... 10
Use the Icons as a Guide .................................................................................................................. 11
Search Report Icon and Picking Pages/customizing budget searches ........................................... 16
Using a Saved Search ....................................................................................................................... 19
Pick Page by Range .......................................................................................................................... 20
Customizing Your Reports .............................................................................................................. 22
User Change Repository Function .................................................................................................. 26
Navigation Bar ................................................................................................................................. 27
Remember to Use ePrint Help ......................................................................................................... 28
Logging out is Important .................................................................................................................. 31
Contact Information ....................................................................................................................... 31
What is Banner ePrint?

The Office of Finance has not provided monthly budget reports to the vast majority of departments since the implementation of Banner in 1998. Banner ePrint allows users to print monthly budget reports as soon as they are available — usually the first business day of the month. It also replaces the distribution of hard-copy reports for departments with a large number of budgets. Please ensure that you see the message indicating that budget reports have been validated before using any budget reports via ePrint.

Employees who monitor and report on budget and payroll activity can obtain access to ePrint. However, before the access is granted, all users must attend Office of Finance ePrint training.

ePrint allows a user to view reports as a PDF (Adobe Portable Document Format) file which can be viewed via Adobe Reader or to download a CSV file into Excel. Keep in mind that when you download a CSV file, you must format the size of the columns to display all information.

ePrint users will be notified via Repository Messages/Notifications when reports are available and validated. If reports are delayed, a message concerning the delay will be posted in the Repository Messages/Notifications.

What is a Repository? A simple way to define a repository is to think of it as a silo of information. Initially, there is only one repository in ePrint — Finance eprint AIR. This repository houses the financial reports currently loaded in ePrint. Eventually, there will be other repositories — i.e. Human Resources, Student. Several Finance reports and the month-end payroll detail reports, NHRSDST and NWRSDST, are currently loaded to this repository.
What Do You Need to Get Started?

- Banner System Account (with appropriate access)
- Current Web Browser
  - Microsoft® Internet Explorer * (Preferred)
  - Mozilla ® Firefox
  - Opera Software ® Opera
  - Apple ® Safari
  - Chrome
- Adobe®Reader
  - Download the latest version from www.adobe.com
  - Run within your browser or in stand-alone mode (recommended)

Banner System Account: Since ODU uses security to control access to at least some of the ePrint reports, you’ll need a Banner system account (user ID and password). Contact the Banner Hotline (bannerhotline@odu.edu) for more information.

REMINDER REGARDING PAYROLL REPORTS - Access to departmental Payroll ePrint Reports must be requested separately. To obtain access to Payroll ePrint reports, the Office of Finance ePrint Payroll Report Request Form must be completed and submitted to Data Control, Office of Finance (requires approval of the Budget Unit Director).

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf

Web Browser: Banner ePrint was designed to run on the newer web browsers. It is recommended that you use the latest released version of your current browser.

Adobe® Reader: This helper application enables you to view, navigate and print documents in the Adobe® Portable Document Format (PDF). You probably already have it installed on your computer. If not, you can get the latest version for free at www.adobe.com.

When you view and print ePrint documents, you can run Adobe® Reader within your browser, or as a stand-alone application. The mode of operation that you select may depend on the browser you use.

Because of some display problems, if you use Microsoft® Internet Explorer, you may wish to run Adobe® Reader independently of the browser.
Office of Finance
Eprint Payroll Report Request Form

Date of Request

Name ___________________________ Department ___________________________

Part Time Reports

☐ Yes
☐ No

Full Time Reports

☐ Yes
☐ No

Date Eprint Training Course Completed ___________________________

Report Access for ALL Budget Codes currently approved for Banner Finance

☐ Yes
☐ No

If “No,” please contact the Data Control staff at 757-683-3257.

Budget Unit Director Approval (required) Date ___________________________

Printed Name ___________________________ Signature ___________________________

Send completed form to the office shown below for processing:

Data Control
Office of Finance

Rev. February 13, 2015
How Do You Access ePrint?

ePrint is accessed through the web from the link shown below. You will use your *MIDAS User ID* and *MIDAS password* to log into ePrint. *You will also need to select the appropriate repository*. A repository is equivalent to access type and what a user has access to print is tied specifically to the user’s Banner access. For Budget and Payroll reports, specify "*FINANCE eprint AIR*" under Repository. Once you enter your User ID, password and repository, press ENTER.

*Type carefully – your account will be locked if you repeatedly attempt to log in with the wrong password. If this happens, a system message will be displayed – contact ITS at 757-683-3192 to have your ePrint account unlocked. Also be sure to verify that you are using the correct repository. If you are trying to log into the wrong repository, you may end up locking your ePrint account.*

https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi
Repository Messages/Notifications

You will see the message “Repository Message is Available” when you log in. Simply click on the Repository Message is Available link to view the information (allow the message a moment to load). You will also see the date of the last message. Please review this information whenever you log in since it is the way we will notify you when new reports are available and verified, and when reports may be delayed. If the message displays on a tab in your browser, be very careful not to close your browser. Most times the message will display as shown in the second screenshot.
When You First Log In

When you first log into ePrint, you will see all the reports available in the selected repository for you to print via ePrint – the budget reports currently available in the FINANCE eprint AIR repository are FGRBDSC and FGRODTA; and the Payroll detail reports, NHRSDST and NWRSNST, are also loaded. For each report shown, you will see the report type, the report name, description and the date and time the report was run (you are able to access older reports by drilling down – discussed later). Keep in mind that you will only see the reports to which you have access. If you have created groups using the My ePrint function (more information later), then the group tabs will also be displayed. You can do one of the following by clicking the appropriate icon:

- Retrieve the latest report in its entirety in PDF format – has navigation choices for orgs on left
- Download the latest report as a text file in its entirety – no navigation choices – must scroll
- Download the latest report as a comma-separated values (CSV) file – into Excel
- List all the reports of a given type (by report type or latest date)

**FGRBDSC, Budget Status Report, similar to FGIBDST (Organization Budget Status Form)** – this report shows the summary information for a budget by sub-account and by the following totals:

- Labor (all salary sub-accounts – no pay details display – details in payroll reports)
- Employee Benefits (4999 pool)
- Non-Personal Services (6999 pool)
- Travel (7999 pool)
- Equipment (9899 pool)
- Transfers
- TOTAL ORGANIZATION (roll-up similar to FGIBSUM)

**FGRODTA, Organizational Detail Activity – similar to FGITRND (Detail Transaction Activity Form)** – shows activity by sub-account (payroll details display totals by pay period – no details by employee name).

**NOTE FOR ALL REPORTS:** At this level you see the most recent report posted – older reports are available in descending date order by drilling down.
BUDGET MANAGEMENT AND FINANCIAL REPORTING

**NHRSDST, Employee Payroll Summary by Org.** – shows payroll activity for each part-time payee by budget code.

**NWRSDST, Employee Payroll Summary by Org.** – shows payroll activity for each full-time payee by budget code.

**REMINDER REGARDING PAYROLL REPORTS** - Access to departmental Payroll Reports must be requested separately. To obtain access to Payroll ePrint reports, the Office of Finance EPrint Payroll Report Request Form must be completed - requires approval of the Budget Unit Director(BUD).

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf

**(NOTE: when reviewing payroll reports, drill down by clicking on the drill icon rather than the PDF icon – this will allow you to choose a sub-account to review – use NEXT to see more reports.)**
“Drilling Down” to Select a Report

Repository List: When you log into the system, you are provided with a list of all the report types on file that you are authorized to see. This highest level of report selection pages is called the repository list. It includes the report types for the repository you selected at login.

At this level, you can either retrieve the latest version of a report in its entirety or you can “drill down” to the report list for a selected report type.

Report List: The report lists displays all the instances on file for a particular report type. At this level, you can either retrieve a specific instance (date) of a report in its entirety, or (if the report is sorted with at least one page key) you can use a page key to target the pages to be included on a particular report instance.
Use the Icons as a Guide

Banner ePrint’s icons make it easy for you. At any level, click the corresponding icon to perform a function. If a function is not available, the icon will not be displayed. If you forget an icon’s function, you can display a brief description by moving your cursor over the icon so that you can see bubble help pop up.

*Use the back browser arrow for navigation purposes.*

Simply point-and-click to . . . retrieve a PDF file, download to TXT, download to CSV into an Excel file, drill down, or use a page key to pick pages/search report.

To retrieve the report in PDF, click the PDF icon. Depending on the way you have Adobe® Reader configured, the report will open within your browser or in stand-alone mode. For best performance, open Adobe® Reader outside of the browser. Technical assistance is provided by your TSP (technical support person) via Footprints. (NOTE: when reviewing payroll reports, you will want to drill down by clicking on the drill icon rather than the PDF icon – this will allow you to choose a sub-account to review – use NEXT to see more reports.)

When you retrieve the PDF file, you will see all the budgets to which you have access displayed in the left hand pane. Clicking the expand/collapse symbol (plus or minus sign) next to the budget code will display the fund code associated with that budget. Clicking the budget code will take you to that specific budget report.

*Use your back browser arrow to return to the Report list shown above.*
Download the TXT version of a report

Click the Text icon to download the text version of a report. When you see the message below, click OK to display the report in the browser – you will be able to see all budgets to which you have access beginning with the first budget. You will need to use the scroll bar. If you have multiple budgets and wish to display one at a time (or in specified groups), this is not the way to do so (refer to the section entitled Search Report Icon and Picking Pages). Use the back browser arrow to return to the menu shown above.
Download the CSV version of a report (into Excel)

This feature is not currently available for Payroll NHRSDST/NWRSST reports.

Click the Data icon to download the comma-separated values version of a report.

When you see the message below, click ok to display the report in the browser – click ok and you will see the file download dialog box. You can choose to Open, Save, or Cancel. If using Internet Explorer, you may use the alternate (right) mouse button to see a menu and select “Save Target As” for a quicker way to save the file. Opening the file may take a while.
If you **Open** the file (remember it opens as a standard CVS file), the report name and run date display. Note that you will need to format the columns. **When you see #### display in columns, that means the columns are not wide enough for the data contained.**

If you select **Save** the file, you will see the Save As dialog box – choose where you want to save your file and use the default file name or choose one of your own – you will then be able to retrieve the file and format the columns as noted above:
“Drill down” for detail (See Report List)

The *See Report List* icon enables you to “drill down” from the repository list to a specific report list. A report list shows all the available reports in date order for the selected report type. This is the recommended method for viewing payroll reports, as noted earlier. Using the “drill down” feature takes you to all reports in descending date order.
Use a page key to pick pages

(Search Report)

Search Report Icon and Picking Pages (customizing budget searches)

When you see the Search Report icon (magnifying glass in the screenshot below), it means you have reports for more than one budget and/or fund. A Page Key is either a Fund or Organization. You will need to “pick” which you want to display. Click the Search Report icon to “pick pages.” This will allow you to select the funds or budgets to appear on the report. If you have access to multiple budgets, you may wish to select which budget codes you want to display. Otherwise, ALL budgets included in your access will display.

If you have multiple budgets/funds, you will want to save your searches so that you do not have to perform a search each time you wish to view individual budget reports. Saving your searches will allow you to display budget reports in ways that are most useful to your department. (If you use your back browser arrow when starting a new search, be sure to uncheck your choices or those choices will be included in the new search.)

After you Click the Search Report icon, you will be taken to Pick Pages for the report selected
Choose either Fund or Organization under Page Key – be sure you are selecting the correct description.

If you want to choose from a list of funds or organizations, under “Pick Values Manually” click Go.

You will now be able to Choose Organizations from the budgets to which you have access. If you have access to more budgets than can display on this screen, you will see the Next button in the lower right corner of your screen. If you wish to go to a specific budget or fund, enter the budget or fund in the field next to the word “go” and click Go. Select the budgets you want to display. Then you can click on Get the Report (see next page.)

You may choose multiple budgets or a range of budgets when creating your search. Saving your search will allow you to access those budget(s) whenever you wish to view budget information without having to choose budgets each time (see next page for info on saving a search).
The budgets you selected will now be displayed and you can choose a report format (PDF, Text, Data). You also have the option of saving your search criteria using a name of your choosing. Then, every time you wish to access reports for those funds or organizations, you can run this search. Using a saved search is especially useful if you have access to budget information for multiple funds or budgets.

If you do not save your search criteria, you will always have to scroll through the full report to find an individual budget. **These saved searches apply to currently available reports as well as future reports.**

Choose a name for your search and Save it. You may not use the same name again. Define a distinct name for each search. *(Remember that you will need to define your searches for each type of report available – ie FGRBDS/FGRODTA/NHRSDST.)*

If you have successfully saved your search, you will see the following message. This means you will be able to use this search when reviewing your reports.

At this point, you can access your reports (discussed earlier) in the format of your choice.

Use the back browser arrow to navigate backwards.
USING A SAVED SEARCH

All saved searches (Organization or Fund, depending on which Page Key you have selected) will display via the drop-down under Saved Searches. Select the search you want to access and click Go. You may also delete searches.

In the example below, a range of budgets was selected and you can now access the report in the format of your choice.
Pick Page by Range

If you want to display a range of budgets – or only one – fill in the range and click Go. Be sure that your range is sequential. **Make sure you use UPPER CASE when entering a budget code range, otherwise, you will see all your budgets and not just the ones contained in the range entered.**

Your range of budgets or funds will display and you will be able to select a report format. Remember, you will only see budgets/funds to which you have access. You also have the option of saving your search criteria using a name of your choosing. Then, every time you wish to access reports for those funds or organizations, you can run this search.

If you do not save your search criteria, you will always have to scroll through the full report to find an individual budget. **These saved searches apply to currently available reports as well as future reports.**

Choose a name for your search and Save it. You may not use the same name again. Define a distinct name for each search. **(Remember that you will need to define your searches for each type of report available – ie FGBRDSC/FGRODTA/NHRSDST.)**
If you have successfully saved your search, you will see the following message.

You will then select how you want your report to display (icon usage discussed previously).

**PDF** – displays in your browser - in the left tab, you will see a list of all funds or organizations for the range you selected.

**Text** – displays in your browser – no tabs will display and you will need to scroll to view.

**Data** – allows download to Excel – you will always see the file download message and will be prompted to open or save your file – not available for Payroll reports, NHRSDST/NWRSDST.
Customizing Your Reports

You can customize your reports to make them more useful by using My ePrint. Click on My ePrint to begin customization. **If you have access to multiple repositories, you must customize the reports in each repository.**

Once you click My ePrint, you will see the information below. You will see Available reports on the left and Selected reports on the right. *(Your available reports will differ from the screenshot below.)* Initially, the information in Selected reports will be blank. The Available reports will display the reports available in the selected repository. Click on the Create Group tab to begin customizing.
Using *My ePrint* allows you to separate the actual reports into separate groups – i.e., Budget Status Report, Organizational Detail Activity, or Payroll Detail Report.

- Enter the **Group name** (this is where you determine how you want your info to display) – in the screenshot below, we are naming the group Budget Status
- Highlight the report you wish to put in the group
- Click the **Add reports to this group** button (right pointing arrow). This will put the report you selected under **Selected reports**.

![Screenshot of My ePrint interface](image)

Once the report is moved into **Selected reports**, you can **Save** your group.
If successful, you will see the message indicating you have successfully added the group. You will also note that the available reports now displays the original default list and you will be able to create other groups using that report. If you attempt to use the same name again, you will see a message “Duplicate Name: Group ‘XXXX’ already exists, please use a unique name.”
If you have set up multiple groups in a repository, you can make a group the default when you log in to ePrint by checking the **Default login group** check box and clicking **Save**.

If you have successfully set your default login group, you will see the following message.
User Change Repository Function

When you log into the repository, you will see your group tabs with the default login group highlighted. You can change your repository by selecting *Change Repository*.

If you attempt to move to a repository where there are no reports for you to view, you will receive the message “There are no reports for you to view in this repository.”
NAVIGATION BAR

The **navigation bar** appears near the top of each ePrint page and displays your current location within the system. Its sections are separated by colons. Click within a section to return to that system page.

Using the **navigation bar** is more specific than using the **back browser arrow** since you can select a particular page instead of having to link backwards one by one through all the pages you have accessed.

---

**ePrint’s Navigation Bar**

- Provides a shortcut to previous pages. Click a section to return to that page.

<table>
<thead>
<tr>
<th>Repository List</th>
<th>Report List</th>
<th>Search Report (Pick Pages)</th>
<th>Page Key Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance : FGRBDSC : Pick Pages : Org</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Banner ePrint**

**Search FGRBDSC (Wed Feb 01, 2012)**

**Finance ePrint AIR : FGRBDSC : Pick Pages**

**Page Key**

- **Pick Values Manually**
  - Go
  - Go

**Range:**

- Go

**Saved Searches:**

- Go

---
Remember to Use ePrint Help!

- Every page (even login page) has link to context-sensitive Help.
- Every Help page has link to:

Contents Page
Alphabetized Index
Related Topics

Help is never more than a click or two away in Banner ePrint, so use the Help pages when you have questions! There is a link just below the title bar on each ePrint page. This link will open a context-sensitive topic with information on that particular part of the system.

In addition, each ePrint Help page provides links to other pages. Near the top of each page, you’ll find a link to the Help’s table of contents and index. Near the bottom of applicable pages, you’ll find links to related topics. There are additional references to related material within most of the Help pages; follow the links.

If your questions are not answered, please send an e-mail to bannerhotline@odu.edu.
FREQUENTLY ASKED QUESTIONS

Do you have questions about something about ePrint? Select FAQ (Frequently Asked Questions).
Table of Contents

Browser Help
CSV Help
Error Message Help
Login Help
Print Help
Report format Help
Repository Help
View Help

Select Topic and click link

When you click the FAQ link, you will be directed to the User FAQ page. The Table of Contents has the major topics of information. Click the topic link to see more information.
LOGGING OUT IS IMPORTANT

For security reasons, you should log out of Banner ePrint if your browser will remain open and you will be leaving your computer unattended.

Note that the Logout link does not appear in your browser when you are viewing a PDF document (if Adobe®Reader is configured to run within the browser).

In order to log out after viewing a PDF document, you must first click the back arrow in your browser to return to an ePrint report selection page. Then you can click the Logout link.

CONTACT INFORMATION

Please direct questions about using ePrint to bannerhotline@odu.edu.